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LAPORAN AKHIR KEGIATAN 

INVENTARISASI DATA SPASIAL PENATAAN RUANG 

 

I. LATAR BELAKANG 

Sesuai dengan Undang-Undang Nomor 26 Tahun 2007 tentang Penataan Ruang dan 

Peraturan Pemerintah Nomor 15 Tahun 2010 tentang Penyelenggaraan Penataan Ruang, 

dimana Penyelenggaraan penataan ruang bertujuan untuk mewujudkan ruang wilayah nasional, 

provinsi, kabupaten/kota (kab/kota) yang aman, nyaman, produktif, dan berkelanjutan 

berlandaskan Wawasan Nusantara dan ketahanan nasional. 

Tingginya dinamika perkembangan wilayah di Kabupaten Tuban perlu ditata 

sedemikian rupa agar sejalan dengan rencana tata ruang wilayah Kabupaten Tuban. Hal ini 

berarti bahwa dinamika di dalam perkembangan wilayah perlu memperhatikan keharmonisan, 

keterpaduan, dan keberlanjutan dari pemanfaatan sumber daya alam, sumber daya buatan, dan 

dengan memperhatikan sumber daya manusia di dalamnya. 

Pemanfaatan ruang dari masing-masing sektor sangat diperlukan sebagai upaya 

pengendalian pemanfaatan ruang agar berjalan sesuai Rencana Tata Ruang Wilayah (RTRW) 

yang telah disepakati. Keberadaan Informasi Geospasial Dasar (IGD) yang konkrit dan valid 

serta up to date dari masing-masing sektor sangat dibutuhkan dalam penataan ruang, dimana 

informasi tersebut merupakan modal dasar dalam melakukan perencanaan wilayah. Peran 

sektoral yang cukup signifikan terhadap pemanfaatan ruang belum diimbangi IGD sebagai 

bahan evaluasi antara kegiatan pembangunan sektoral dengan RTRW, untuk itu maka dalam 

kegiatan ini bertujuan untuk menginventarisasi IGD dari masing-masing sektoral terkait 

penataan ruang yang nantinya dapat menjadi data dasar dalam perencanaan. 

 
II. MAKSUD DAN TUJUAN 

Maksud dari kegiatan ini adalah mengoptimalkan peran OPD dilingkup Pemerintah 

Kabupaten Tuban dalam mendukung kegiatan penataan ruang melalui inventarisasi Informasi 

Geospasial Dasar (IGD). 

Tujuan dari kegiatan ini adalah melakukan inventarisasi Informasi Geospasial Dasar 

(IGD) untuk penataan ruang di wilayah Kabupaten Tuban. 

 
III. TINJAUAN DASAR HUKUM 

Landasan hokum yang menjadi dasar pertimbangan dalam kegiatan Inventarisasi Data 

Spasial Penataan Ruang adalah: 

1. Undang-Undang Nomor 5 Tahun 1960 tentang Peraturan Dasar Pokok-Pokok Agraria; 

2. Undang-Undang Nomor 25 Tahun 2004 tentang Sistem Perencanaan Nasional; 

3. Undang-Undang Nomor 31 Tahun 2004 tentang Perikanan; 

4. Undang-Undang Nomor 32 Tahun 2004 tentang Pemerintahan Daerah; 

5. Undang-Undang Nomor 26 Tahun 2007 tentang Penataan Ruang; 

6. Undang-Undang Nomor 4 Tahun 2011 tentang Informasi Geospasial; 

Peraturan Pemerintah Nomor 10 Tahun 2000 tentang Ketelitian Peta untuk Penataan Ruang 

Wilayah; 
 

 

 

 

 

 
 



 

 

 

IV. RUANG LINGKUP KEGIATAN 

Ruang lingkup kegiatan Inventarisasi Data Spasial Penataan Ruang ini antara lain: 

1. Membuat buku pedoman 

2. Kompilasi Data dan Informasi 

3. Melakukan pendampingan inventarisasi IGD kepada operator OPD 

4. Melaporkan Hasil Inventarisasi 

 
V. METODE DAN PENDEKATAN KEGIATAN 

Metode dan pendekatan kegiatan yang digunakan dalam kegiatan ini telah disimpulkan 

dalam bentuk rencana kerja yang sesuai dengan ruang lingkup kegiatan tersebut di atas dan 

dilengkapi dengan diagram kerangka pikir, nama beserta tugas dari masing-masing tenaga ahli, 

waktu dan tempat pelaksanaan kegiatan dan lain sebagainya yang sehubungan dengan 

pelaksanaan kegiatan di lapangan. 

Kerangka pikir dari kegiatan Inventarisasi Data Spasial Penataan Ruang dapat dilihat 

sebagaimana gambar diagram di bawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.1 Diagram Kerangka Pikir Kegiatan 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

 

 

Kebutuhan personil dalam kegiatan Inventarisasi Data Spasial Penataan Ruang adalah 

sebagai berikut: 

Tabel 4.1 Tenaga Ahli dan Pendukung Kegiatan 

Kualifikasi 

Pendidikan 

 

 
Tugas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kemudian untuk waktu dan tempat pelaksaan kegiatan dilakukan pada: 

Hari : Senin – Kamis dan Kamis – Jumat 

Tanggal : 28 – 31 Agustus 2017 dan 14 – 15 September 2017 

Pukul : 08.30 – selesai 

Tempat : Gedung LPSE Kabupaten Tuban Lt. 2 

Jl. R.A. Kartini No. 02, Kutorejo, Kec. Tuban, Kab. Tuban 62311 

 
VI. JADWAL KEGIATAN 

Kegiatan Inventarisasi Data Spasial Penataan Ruang dilaksanakan selama lebih kurang 

2 (dua) bulan kalender atau 60 hari kalender terhitung sejak surat perjanjian kerja 

ditandatangani. Berikut adalah jadwal kegiatan yang telah dibuat: 

Tabel 5.1 Jadwal Kegiatan 

 

No. 

 

Kegiatan 

Bulan (Minggu Ke-) 

I II 

1 2 3 4 1 2 3 4 

1. Persiapan dan laporan pendahuluan         

2. Penyusunan dan Pembuatan data spasial berbasis SIG         

3. Penyempurnaan Inventarisasi data spasial akhir         

4. Penyerahan hasil pekerjaan         

 

 
 

No. Nama Posisi 
 

  

 
 

1. 

 

Prof. Dr. Ir. Bangun 

Muljo Sukojo, DEA., 

DESS 

 

Team Leader 

(Tenaga Ahli 

Geomatika) 

 
Profesor/S3/S2/S1 

Geomatika 

Bertanggung jawab 

atas pelaksanaan 

kegiatan mulai dari 

awal pekerjaan 

sampai selesai 

 
2. 

 

Muharrama Putra 

Prayoga 

Operator 

Teknis Basis 

Data 

Geospasial 

 
S1 Geomatika 

Melakukan 

pendampingan 

inventarisasi IGD 

kepada operator OPD 

 
3. 

 
Dhiyaulhaq Al Majid 

Koordinator 

Inventarisasi 

Data 

Geospasial 

 
S1 Geomatika 

Melakukan 

pendampingan 

inventarisasi IGD 

kepada operator OPD 

 
4. 

 

Izhad 

Miftachurrozaq 

Operator 

Inventarisasi 

Data 

Geospasial 

 
S1 Geomatika 

Melakukan 

pendampingan 

inventarisasi IGD 

kepada operator OPD 

 

 
5. 

 

 
Salwa Nabilah 

 
 

Staf 

Administrasi 

 

 
S1 Geomatika 

Melakukan 

pendampingan 

inventarisasi IGD 

kepada operator OPD 

serta mengurusi 

administrasi 

 



 

 

 

 

VII. HASIL KEGIATAN 

1. Data setiap OPD yang dijadikan bahan inventarisasi. Antara lain: 

 Aset Tanah Kecamatan Tuban 

 Peta Jaringan Jalan Kabupaten Tuban 

 Data Sekolah Se-Kab. Tuban 

 Daftar Izin Usaha Pertambangan (UIP) Operasi Produksi Kabupaten Tuban 

 Daftar Izin Usaha Pertambangan Operasi Produksi Kabupaten Tuban 

 Daftar Perijinan Izin Mendirikan Bangunan IMB Kecamatan Grabagan 

 Data Perijinan HO Kecamatan Rengel Tahun 2016 

 Pemerintah Kabupaten Tuban Dinas Penanaman Modal Pelayanan Terpadu Satu 

Pintu dan Tenaga Kerja 

 Pemerintah Kabupaten Tuban Dinas Pertanian dan Pertahanan Pangan 

 Pemerintah Kabupaten Tuban Kecamatan Kerek 

 Pemerintah Kabupaten Tuban Kecamatan Widang 

 Pemerintah Kabupaten Tuban Kecamatan Bancar 

 Pemerintah Kabupaten Tuban Kecamatan Rengel 

 Pemerintah Kabupaten Tuban Kecamatan Grabagan 

 Pemerintah Kabupaten Tuban Kecamatan Jatirogo 

 Pemerintah Kabupaten Tuban Kecamatan Kenduruan 

 Pemerintah Kabupaten Tuban Kecamatan Merakurak 

 Pemerintah Kabupaten Tuban Kecamatan Parengan 

 Pemerintah Kabupaten Tuban Kecamatan Plumpang 

 Pemerintah Kabupaten Tuban Kecamatan Semanding 

 Pemerintah Kabupaten Tuban Kecamatan Tambakboyo 

 Pemerintah Kabupaten Tuban Sekretariat Daerah 

 Rekapitulasi Permohonan Izin Usaha Pertambangan Kabupaten Tuban per 16 

Januari 2016 

 Rekapitulasi Surat Tata Ruang Mineral Bukan Logam dan Bantuan Kabupaten 

Tuban 2017 

 Tutorial Inventarisasi Data Spasial 

(Terlampir) 

2. Data Google Maps yang telah terupdate oleh data-data yang tersedia. 

3. Pemahaman peserta terhadap penggunaan google maps dan perangkat lunak pengolah 

informasi geospasial menjadi bertambah. Yang awalnya belum mengetahui menjadi 

tahu sedangkan yang sudah mengetahuinya pengetahuannya menjadi bertambah. 

 
VIII. PENUTUP 

Kesimpulan yang didapat dari kegiatan ini adalah peserta sangat antusias dengan 

adanya kegiatan ini sehingga data yang tersedia dapat diolah dengan baik dan sesuai dengan 

target. 

Rekomendasi untuk kegiatan yang serupa selanjutnya adalah data yang diperlukan 

sebaiknya dikumpulkan sebelum kegiatan ini dilaksanakan supaya data mudah dimengerti 

dan data juga tersusun dengan rapi. 
 

 

 

 



 

 

 

IX. LAMPIRAN 

1. Curriculum Vitae (CV) dari Tenaga Ahli 

2. Absensi Peserta 

3. Panduan (tutorial) 

4. Hasil Inventarisasi 

 Aset Tanah Kecamatan Tuban 

 Peta Jaringan Jalan Kabupaten Tuban 

 Data Sekolah Se-Kab. Tuban 

 Daftar Izin Usaha Pertambangan (UIP) Operasi Produksi Kabupaten Tuban 

 Daftar Izin Usaha Pertambangan Operasi Produksi Kabupaten Tuban 

 Daftar Perijinan Izin Mendirikan Bangunan IMB Kecamatan Grabagan 

 Data Perijinan HO Kecamatan Rengel Tahun 2016 

 Pemerintah Kabupaten Tuban Dinas Penanaman Modal Pelayanan Terpadu Satu 

Pintu dan Tenaga Kerja 

 Pemerintah Kabupaten Tuban Dinas Pertanian dan Pertahanan Pangan 

 Pemerintah Kabupaten Tuban Kecamatan Kerek 

 Pemerintah Kabupaten Tuban Kecamatan Widang 

 Pemerintah Kabupaten Tuban Kecamatan Bancar 

 Pemerintah Kabupaten Tuban Kecamatan Rengel 

 Pemerintah Kabupaten Tuban Kecamatan Grabagan 

 Pemerintah Kabupaten Tuban Kecamatan Jatirogo 

 Pemerintah Kabupaten Tuban Kecamatan Kenduruan 

 Pemerintah Kabupaten Tuban Kecamatan Merakurak 

 Pemerintah Kabupaten Tuban Kecamatan Parengan 

 Pemerintah Kabupaten Tuban Kecamatan Plumpang 

 Pemerintah Kabupaten Tuban Kecamatan Semanding 

 Pemerintah Kabupaten Tuban Kecamatan Tambakboyo 

 Pemerintah Kabupaten Tuban Sekretariat Daerah 

 Rekapitulasi Permohonan Izin Usaha Pertambangan Kabupaten Tuban per 16 

Januari 2016 

 Rekapitulasi Surat Tata Ruang Mineral Bukan Logam dan Bantuan Kabupaten 

Tuban 2017 
 

 

 



 

 

 

 

 

 

 

 

 

 

 

 



 

CURRICULUM VITAE 

 

1.1 Nama Lengkap (dengan gelar) Prof.Dr.Ir. Bangun Muljo Sukojo,DEA,DESS 

1.2 Jabatan Fungsional Guru Besar 

1.3 NIP/NIDN 195305271983031001 / 0027055309 

1.4 Tempat dan Tanggal Lahir Malang / 27 Mei 1953 

1.5 Alamat Rumah Jalan Teknik Geodesi Blok P No 5 ITS Surabaya 

1.6 Nomor Telepon/Faks 0315932370 / - 

1.7 Nomor HP 081330617359 

1.8 Alamat Kantor Kampus ITS Sukolilo Surabaya 

1.9 Nomor Telepon/Faks 0315929487 / 0315929486 

1.10 Alamat e-mail bangunms@gmail.com 

1.11 Bidang Keilmuan Teknik Geomatika 

 

II RIWAYAT PENDIDIKAN 

 
 S-1 S-2 S-3 

Nama Perguruan 

Tinggi 

ITB Bandung 1. Universitas Pierre & 

Marie Curri (Paris 6) - 

Ecole Nationale des 

Siences Geographiques 

(ENSG) St.Mande Paris 

Perancis 

 

2. Universitas Paul 

Sabatier (Toulouse 3) 

Perancis 

Universitas Paul 

Sabatier (Toulouse 3) 

Perancis 

Bidang Ilmu Teknik Geodesi 1. Teledetection 

(Remote Sensing/ 

Penginderaan Jauh) 

 

2. Ecologie Terrestre et 

Limnique (Ecology of 

Land and Aquatic/ 

Ekologi Daratan dan 
Perairan) 

Teledetection et 

Ecologie (Remote 

Sensing and 

Ecology/Penginderaan 

Jauh dan Ekologi) 

Tahun Masuk-Lulus 1973 - 1981 1. 1986 - 1987 
2. 1987 - 1988 

1988 - 1991 

 

C. PENGALAMAN PENELITIAN (Bukan Skripsi, Tesis, maupun Disertasi) 
Urutkan judul penelitian yang pernah dilakukan(sebagai ketua) selama 5 tahun terakhir 

dimulai dari penelitian yang paling diunggulkan menurut Saudara sampai penelitian yang 

tidak diunggulkan. 

No. Tahun Judul Penelitian Pendanaan 

Sumber* 

 

Jml (Juta Rp) 

1 2008 Studi Perubahan Suhu Permukaan Laut 

Dalam Rangka Pembuatan Sistem 

Informasi Kelautan (Studi Kasus 

Pembuangan Lumpur Lapindo di Selat 

DIPA LPPM – 

ITS 

30 

mailto:bangunms@gmail.com


 

  Madura)   

2 2009 Studi Sedimentasi dan Perubahan 

Garis Pantai Dalam Rangka 

Pembuatan Sistem Informasi Kelautan 

(Studi Kasus Pembuangan Lumpur 

Lapindo di Selat Madura) 

DIPA LPPM – 

ITS 

30 

3 2010 Studi Potensi Laut Dalam Rangka 

Pembuatan Sistem Informasi Kelautan 

(Studi Kasus Wilayah Pesisir dan 

Pantai Selat Madura) 

DIPA LPPM – 

ITS 

30 

4 2010 Pembangunan Sistem Informasi 

Kelautan Berbasis pada Studi 

Paramater Kelautan Dengan Metode 

Penginderaan Jauh dan Sistem 

Informasi Geografis (Studi Kasus : 

Pantai dan Pesisir Selat Madura) 

Stranas DP2M 

Dikti Diknas 

57 

5 2011 Studi Pembuatan Sistem Informasi 

Kelautan Berbasis WebGIS (Studi 

Kasus Wilayah Pesisir dan Pantai Selat 

Madura) 

DIPA LPPM – 

ITS 

45 

6 2011 Karakteristik Dosen dan 

Pengembangan Model Prestasi 

Akademis Dosen Berbasis Sistem 

Informasi Geografis 

Hibah Pekerti 

DP2M Dikti 

Diknas 

75,4 

7 2011 Studi Dampak Pencemaran Lumpur 

Sidoarjo Tehadap Perubahan Garis 

Pantai Surabaya - Sidoarjo 

DIPA LPPM – 

ITS 

40 

8 2012 Karakteristik Dosen dan 

Pengembangan Model Prestasi 

Akademis Dosen Berbasis Sistem 

Informasi Geografis 

Hibah Pekerti 

DP2M Dikti 

Diknas 

80 

9 2012 Analisa Algoritma Citra Satelit NOAA- 

AVHRR dan MODIS Untuk Pemetaan 

Distribusi Suhu Permukaan Laut 

Sebagai Indikator Daerah Tangkapan 

Ikan (Fishing Ground) Berbasis 

WebGIS 

DIPA LPPM – 

ITS 

60 

10 2012 Pemberdayaan Laboratorium Kadaster 

dan Kebijaksanaan Pertanahan 

Guna Menunjang Program Lab-Based 

Education Di Bidang Penataan dan 

Pengembangan Tanah di Wilayah 

Pesisir Berbasis Pada GIS 

DIPA LPPM – 

ITS 

31 

11 2012 Pembangunan Sistem Informasi 

Transportasi Untuk Analisa Strategi 

Moda Transportasi Guna Mendorong 

Jasa Industri Nasional Berbasiskan 

Pada WebGIS (Studi Kasus Wilayah 

Gerbangkertasusila Plus) 

MP3EI DP2M 
Dikti Diknas 

154 

12 2013 Analisa Algoritma Citra Satelit NOAA- DIPA LPPM – 100 



 

  AVHRR dan MODIS Untuk Pemetaan 

Distribusi Suhu Permukaan Laut 

Sebagai Indikator Daerah Tangkapan 

Ikan (Fishing Ground) Berbasis 

WebGIS 

ITS  

13 2013 Karakteristik Dosen dan 

Pengembangan Model Prestasi 

Akademis Dosen Berbasis Sistem 

Informasi Geografis 

Hibah Pekerti 

DP2M Dikti 

Diknas 

80 

14 2013 Pembangunan Sistem Informasi 

Transportasi Untuk Analisa Strategi 

Moda Transportasi Guna Mendorong 

Jasa Industri Nasional Berbasiskan 

Pada WebGIS (Studi Kasus Wilayah 

Gerbangkertasusila Plus) 

MP3EI DP2M 
Dikti Diknas 

154 

15 2013 Inventarisasi Dan Pemetaan 

Biodiversity (Keanekaragaman Hayati) 

Ekosistem Mangrove Di Jawa Timur 

Dengan Menggunakan Teknologi 

Penginderaan Jauh Dan Berbasis 

WebGIS. 

DIPA LPPM – 

ITS 

99 

16 2015 Integrasi Spasial Sistem Dinamik untuk 

Analisis Perubahan Pola Aliran Sungai 

Dan Daerah Genangan di Pantai 

Surabaya – Sidoarjo Menggunakan 

Citra Satelit Penginderaan Jauh 

Berbasis WebGIS 

Hibah 

Kompetensi 

DP2M Dikti 

Diknas 

120 

17 2016 PEMANTAUAN PERAIRAN SELAT 

MADURA DENGAN 

PENGEMBANGAN ALGORITMA 

TOTAL SUSPENDED SEDIMENT 

(TSS) DAN PERUBAHAN GARIS 

PANTAI DARI CITRA SATELLIT 

MULTITEMPORAL 

Hibah 

Kompetensi 

DP2M Dikti 

Diknas 

100 

18 2017 ANALISIS KETELITIAN 

ORTHOREKTIFIKASI CITRA 

PLEIADES DAN QUICKBIRD 

UNTUK PEMBUATAN PETA 

DASAR RENCANA DETAIL TATA 

RUANG TERBUKA HIJAU DALAM 

PEMBANGUNAN 

INFRASTRUKTUR DATA SPASIAL 

(STUDI KASUS: PERKOTAAN 

TUBAN) 

DIPA ITS 35 

19 2017 ANALISA ESTIMASI 

PRODUKTIVITAS PADI DENGAN 

CITRA LANDSAT 8 

BERDASARKAN FASE TUMBUH, 

PENGAMATAN IN-SITU DAN 

MODEL PERAMALAN 

Hibah Penelitian 

Unggulan PT 

DP2M Dikti 

Diknas 

198 



 

  AUTOREGRESIF INTEGRATED 

MOVING AVERAGE (ARIMA) 

(Studi Kasus: Kabupaten Bojonegoro) 

  

20 2017 NILAI PENTING POTENSI 

EKONOMI EKOSISTEM 

MANGROVE DENGAN 

MENGGUNAKAN NDVI CITRA 

SATELIT RESOLUSI TINGGI 

UNTUK MENUNJANG ECO 

WISATA DAERAH PAMURBAYA 

(Studi Kasus: Pantai Timur Surabaya) 

Mandiri  

21 2017 ANALISA PEMANFAATAN 

POTENSI ENERGI PANAS BUMI 

SEBAGAI PENUNJANG ENERGI 

LISTRIK UMKM PADA KAWASAN 

GUNUNG IJEN 

Mandiri  

22 2017 ANALISA WILAYAH PESISIR 

MENGGUNAKAN CITRA 

PLEIADES DAN 

SPOT6 UNTUK PERENCANAAN 

LAHAN AKUAKULTUR 

(STUDI KASUS: KECAMATAN 

JENU, TUBAN) 

Mandiri  

*Tuliskan sumber pendanaan: PDM, SKW, Pemula, Fundamental, Hibah Bersaing, Hibah 

Pekerti, Hibah Pascasarjana, Hikom, Stranas, Kerjasama Luar Negeri dan Publikasi 

Internasional, RAPID, Unggulan Stranas, atau sumber lainnya. 

 
D. Pengalaman Pengabdian Kepada Masyarakat Dalam 5 Tahun Terakhir 

 

No. Tahun Judul Pengabdian Kepada 

Masyarakat 

Pendanaan 

Sumber* 

Jml (Juta Rp) 

1 2009 Panitia Pengadaan Barang/Jasa 

Pekerjaan Pembangunan Kapal 

Catamaran Pusat Pemetaan Dasar 

dan Kelautan dan Kedirgantaraan 

(PDKK) Bakosurtanal 

DIPA 

BAKOSURTANAL 

30 

2 2010 Tim Supervisi Pembangunan Kapal 

Catamaran Pusat Pemetaan Dasar 

dan Kelautan dan Kedirgantaraan 

(PDKK) Bakosurtanal 

DIPA 

BAKOSURTANAL 

50 

3 2011 Survey Pendahuluan Geologi dan 

Manifestasi Panas Bumi di Tiris 

Kabupaten Probolinggo dan 

Lumajang, Propinsi Jawa Timur 

DIPA ESDM 
Propinsi Jawa 

Timur 

60 

4 2013 (Ib-IKK) Informasi Geospasial 
(Peta) 

DP2M Dikti Diknas 100 

5 2014 Pembimbing Lapangan Kemah 
Kerja di Kecamatan Trawas 

DIPA ITS 25 

6 2015 Pembimbing Lapangan Kemah DIPA ITS 25 



 

  Kerja di Kecamatan Trawas   

7 2016 Optimalisasi Spasial Desa Claket 
sebagai Desa Wisata Geothermal 

DIPA ITS 25 

8 2017 Social Toponym of Urban 

Ecotourism sebagai Upaya 

Inventarisasi Potensi Wisata 

Perkotaan Wilayah Dolly Berbasis 

WebGIS 

BOPTN ITS 50 

9 2017 Aspek Toponimi Pada Penamaan 

Rupa Bumi Desa Tunggulwulung 

Kecamatan Pandaan Kabupaten 

Pasuruan 

BOPTN ITS 15 

 

* Tuliskan sumber pendanaan: Penerapan IPTEKS-SOSBUD, Vucer, Vucer Multitahun, UJI, 

Sibermas, atau sumber lainnya. 

 

E. Pengalaman Penulisan Artikel Ilmiah Dalam Jurnal Dalam 5 Tahun Terakhir 

 

No. Judul Artikel Ilmiah Volume/ 

Nomor/Tahun 

Nama Jurnal 

1 “Pemanfaatan Citra Aster 

untuk Penentuan Jalur 

Transportasi Darat di 

Kabupaten Tanah Laut, 

Propinsi Kalimantan Barat 

Vol 3 No 2 

Februari 2008 

Jurnal Geoid ISSN : 1858- 

2281 

2 ,”Pembuatan Peta Bathymetri 

Menggunakan Citra Satelit 

Formosat 2 Di Kepulauan 

Seribu” 

Vol 3 No 2 

Februari 2008 

Jurnal Geoid ISSN : 1858- 

2281 

3 “Pemetaan Prediksi Lokasi 

Mineral Uranium Dengan 

Citra Landsat 7 ETM+ (Studi 

Kasus : Kabupaten Ketapang, 

Kalimantan Barat)” 

Vol 3 No 2 

Februari 2008 

Jurnal Geoid ISSN : 1858- 

2281 

4 “Studi Perbandingan Suhu 

Permukaan Laut 

Menggunakan Citra Satelit 

NOAA-AVHRR Dengan Argo 

Float Di Perairan Selatan 

Jawa, Bali Dan Nusa 

Tenggara” 

Vol 3 No 2 

Februari 2008 

Jurnal Geoid ISSN : 1858- 

2281 

5 “Studi Perubahan Suhu 

Permukaan Laut Dalam 

Rangka Pembuatan Sistem 

Informasi Kelautan (Studi 

Kasus Pembuangan Lumpur 

Lapindo di Selat Madura) 

Vol 3 No 2 

Februari 2008 

Jurnal Geoid ISSN : 1858- 

2281 

6 “Studi Sedimentasi dan 
Perubahan Garis Pantai 

Vol 5 No 1 Agustus 
2009 

Jurnal Geoid ISSN : 1858- 
2281 



 

 Dalam Rangka Pembuatan 

Sistem Informasi Kelautan 

(Studi Kasus Pembuangan 

Lumpur Lapindo di Selat 

Madura) 

  

7 “Studi Potensi Laut Dalam 

Rangka Pembuatan Sistem 

Informasi Kelautan (Studi 

Kasus Wilayah Pesisir dan 

Pantai 

Selat Madura 

Vol 5 No 2 

Februari 2010 

Jurnal Geoid ISSN : 1858- 

2281 

8 Pembangunan Sistem 

Informasi Kelautan Berbasis 

pada Studi Paramater 

Kelautan Dengan Metode 

Penginderaan Jauh dan Sistem 

Informasi Geografis (Studi 

Kasus : Pantai dan Pesisir 

Selat Madura 

Vol 5 No 2 

Februari 2010 

Jurnal Geoid ISSN : 1858- 

2281 

9 Ekstraksi Kandungan Air 

Kanopi Daun Tanaman Padi 

Dengan Data Hyperspektral 

Vol 16 No 1 

Agustus 2010 

Jurnal Ilmiah Geomatika 

ISSN: 0854-2759 

Nomor Akreditasi 128/Akred- 

LIPI/P2MBI/06/2008 

10 Explorasi Data Field 

Spectrometer dan Airborne- 

Hyperspectral untuk Estimasi 

Canopy Water Content 

Tanaman Padi di Indramayu, 

Jawa Barat 

Vol 16 No 1 

Agustus 2010 

Jurnal Ilmiah Geomatika 

ISSN: 0854-2759 
Nomor Akreditasi 128/Akred- 

LIPI/P2MBI/06/2008 

11 Prediksi Kandungan Nitrogen 

Daun Padi pada beberapa 

Tingkat Dosis Pupuk dengan 

Analisis Pergeseran Tepi 

Kanal Merah (Red Edge Shift) 

Data Hiperspektral 

Vol 11 No 3 

Desember 2009 

Jurnal Sains dan Teknologi 
Indonesia ISSN: 1410 --9509 

Nomor Akreditasi 126/Akred- 

LIPI/P2MBI/06/2008 

12 Eksplorasi Informasi Data 

Hyperspektral untuk 

Memprediksi Parameter 

Biokimia Tanaman Padi Pada 

Panjang Gelombang Tampak 

Mata (Visible Bands) dan 

Inframerah Dekat (Near 

Infrared Bands) 

Vol 12 No 2 

Agustus 2010 

Jurnal Sains dan Teknologi 
Indonesia ISSN: 1410 --9509 

Nomor Akreditasi 126/Akred- 
LIPI/P2MBI/06/2008 

13 Prediksi Parameter-Parameter 

Biofisika Tanaman Padi dari 

Data Groundspectrmeter 

dan Hyperspectral Pesawat 

Terbang dengan 

Menggunakan Teknik Partial 

Least Square 

Vol 12 No 1, 
Januari 2011 

Jurnal Teknologi 

Lingkungan ISSN 1441 - 
318X 

Akreditasi Skep Kepala LIPI 

No. 816/D/2009 

Skep Kepala LIPI No. 

1417/D/2006 



 

 Regression (PLSR) dan 

Normalized Diference Spectral 

Index (NDSI) 

 Kpts Dirjen Dikti Depdiknas 

RI No. 34/DIKTI/Kep/2003 

14 Klasifikasi Fase Pertumbuhan 

Tanaman Padi Dari Data 

Hyperspectral Penginderaan 

Jauh (HYMAP) Dengan 

Teknik Spectral Angle Mapper 

(SAM) Di Kabupaten Subang 

dan Indramayu, Jawa Barat 

Vol 7 No 1 
Januari 2011 

Jurnal Rekayasa Lingkungan 

ISSN 0216.7735 
Akreditasi No 169/Akred- 

LIPI/P2MBI/07/2009 

15 Pembangunan Sistem 

Informasi Transportasi Laut 

untuk Analisa Strategi 

Transportasi Laut Guna 

Mendorong Jasa Industri 

Nasional Berbasiskan Pada 

WebGIS (Studi Kasus 

Wilayah Gerbangkertasusila 

Plus) 

Vol 7 No 1 Agustus 
2012 

Jurnal Geoid ISSN : 1858- 

2281 

16 ANALISIS PERUBAHAN 

LUAS HUTAN DI JAWA 

TIMUR MENGGUNAKAN 

CITRA SATELIT TERRA 

MODIS ANTARA TAHUN 

2007 – 2011 

(Studi Kasus : Daerah Propinsi 

Jawa Timur Berdasarkan Indek 

Vegetasi NDVI dan EVI) 

Vol 8 No 1 Agustus 
2012 (1-6) 

Jurnal Geoid ISSN : 1858- 

2281 

17 ANALISIS PERUBAHAN 

SUHU PERMUKAAN 

TANAH DENGAN 

MENGGUNAKAN CITRA 

SATELIT TERRA DAN 

AQUA MODIS 

(Studi Kasus : Daerah 
Kabupaten Malang dan 
Surabaya) 

Vol 8 No 1 Agustus 
2012 (85-93) 

Jurnal Geoid ISSN : 1858- 

2281 

18 STUDI PASANG SURUT DI 

PERAIRAN INDONESIA 

DENGAN MENGGUNAKAN 

DATA SATELIT 

ALTIMETRI JASON-1 

Vol 8 No 1 Agustus 
2012 (58-67) 

Jurnal Geoid ISSN : 1858- 

2281 

19 ANALISA 

PERBANDINGAN 

KONSENTRASI KLOROFIL 

ANTARA CITRA SATELIT 

TERRA DAN AQUA/MODIS 

DITINJAU DARI SUHU 

PERMUKAAN LAUT DAN 

Vol 8 No 1 Agustus 
2012 (68-74) 

Jurnal Geoid ISSN : 1858- 

2281 



 

 MUATAN PADATAN 
TERSUSPENSI (Studi Kasus : 

Perairan Selat Madura dan 

sekitarnya) 

  

20 ANALISA SEA LEVEL 

ANOMALY 

MENGGUNAKAN 

RETRACKING WAVEFORMS 

DARI DATA SATELIT 

ALTIMETRI JASON-2 

(Studi Kasus : Pesisir Pulau 

Bali) 

Vol 8 No 2 Februari 
2013 (160-167) 

Jurnal Geoid ISSN : 1858- 

2281 

21 IDENTIFIKASI SEBARAN 

SEDIMENTASI DAN 

PERUBAHAN GARIS 

PANTAI DI PESISIR 

MUARA PERANCAK-BALI 

MENGGUNAKAN DATA 

CITRA SATELIT ALOS 

AVNIR-2 DAN SPOT-4 

Vol 9 No 1 Agustus 
2013 (73-80) 

Jurnal Geoid ISSN : 1858- 

2281 

22 STUDI TINGKAT 

KERAPATAN MANGROVE 

MENGGUNAKAN INDEKS 

VEGETASI 

Vol 9 No.2 
Feb 2014 (101-107) 

Jurnal Geoid ISSN : 1858- 

2281 

23 ANALISA INDEX 

VEGETASI NDVI DAN 

MCARI UNTUK 

PENENTUAN TUTUPAN 

LAHAN SAWAH 

Studi Kasus: Kabupaten 

Karawang 

Vol.9 No.2 Feb 

2014 (180-185) 

Jurnal Geoid ISSN : 1858- 

2281 

24 OPTIMALISASI 

PEMETAAN FASE 

PERTUMBUHAN PADI 

BERDASARKAN ANALISA 

POLA REFLEKTAN 

DENGAN DATA 

HIPERSPEKTRAL 

Studi Kasus : Kabupaten 

Karawang 

Vol.9 No.2 
Feb 2014 (121-127) 

Jurnal Geoid ISSN : 1858- 

2281 

25 HASIL ANALISA KADAR 

NITROGEN VEGETASI 

PADI DENGAN DATA 

HYPERSPECTRAL 

MENGGUNAKAN INDEX 

VEGETASI (Studi Kasus: 

Karawang) 

Vol.9 No.2 
Feb 2014 (158-165) 

Jurnal Geoid ISSN : 1858- 

2281 

26 ANALISA KESEHATAN 

MANGROVE 

BERDASARKAN NILAI 

Vol.9 No.2 
Feb 2014 (142-149) 

Jurnal Geoid ISSN : 1858- 

2281 



 

 NORMALIZED 

DIFFERENCE VEGETATION 

INDEX MENGGUNAKAN 

CITRA ALOS AVNIR-2 

  

27 Studi Persebaran Klorofil-a 

Menggunakan Citra Aqua 

MODIS dan Landsat 8 di 

Pantai Surabaya–Sidoarjo 

Dampak Lumpur Lapindo 

Vol.10 No.1 

Agustus 2014 

Jurnal Geoid ISSN : 1858- 

2281 

28 Identifikasi Variasi Perubahan 

Garis Pantai Akibat Abrasi dan 

Akresi 

Vol_10_No_1_2014 

Agustus 2014 

(17-29) 

Jurnal Segara ISSN : 1907- 

0659. Nomor Akreditasi: 

559/AU2/P2MI-LIPI/09/2013 

(Periode Oktober 2013 - 

Oktober 2016) 

29 Model Variasi Harian Suhu 

Permukaan Laut dari Data 

MODIS dan In Situ 

Menggunakan Metoda 

Parameterisasi Empirik di 

Samudera Hindia 

Vol_10_No_1_2014 

Agustus 2014 

(87-97) 

Jurnal Segara ISSN : 1907- 

0659. Nomor Akreditasi: 

559/AU2/P2MI-LIPI/09/2013 

(Periode Oktober 2013 - 

Oktober 2016) 

30 Pembuatan Peta Dasar RDTR 

Kawasan Pesisir 

Dengan Kajian Ketelitian 

Geometrik Citra Satelit 

Pleiades 1B dan Geoeye untuk 

(Studi Kasus: Pesisir 

Surabaya, Jawa Timur) 

Proceding Bunga Rampai Remote 

Sensing Indonesia, Center of 

Remote Sensing ITS Bandung, 

2017 

31 Penentuan Daerah Tangkapan 

Ikan Dengan Menggunakan 

Analisis Suhu Permukaan Laut 

Dari Citra Satelit Modis Level 

1B (Studi Kasus: Selat Bali) 

Proceding Bunga Rampai Remote 

Sensing Indonesia, Center of 

Remote Sensing ITS Bandung, 

2017 

 

F. Pengalaman Penyampaian Makalah Secara Oral Pada Pertemuan / Seminar Ilmiah 

Dalam 5 Tahun Terakhir 

 

No. Nama Pertemuan 

Ilmiah / Seminar 

Judul Artikel Ilmiah Waktu dan Tempat 

1 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Analisis Akurasi Penentuan Luas 

Objek PBB Menggunakan Citra 

QUICKBIRD dan IKONOS 

24 Oktober 2007, 

Jakarta 

2 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Pendatan Objek PBB Rumah 

Mewah Dengan Citra Satelit 

QUICKBIRD dan Foto Teristris 

Digital 

24 Oktober 2007, 

Jakarta 

3 Prafora Tematik 
Sumber Daya Alam 

Strategi dan Operasional Aplikasi 
Remote Sensing dan Sistem 

21 Juni 2008, Bandung 



 

 Darat Bakosurtanal Informasi Geografis  

4 Fora Tematik Sumber 

Daya Alam Darat 

IGTE Bakosurtanal 

Strategi dan Operasional Aplikasi 

Remote Sensing dan Sistem 

Informasi Geografis Untuk 

Pengelolaan Sumber Daya Alam, 

Pemulihan Lingkungan dan 

Ketahanan Pangan 

6 – 9 Agustus 2008, 

Jakarta 

5 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Pemznfaatan Citra Aster Untuk 

Penentuan Jalur Transportasi Darat 

Kabupaten Tanah Laut Kalimantan 

Selatan 

29-30 Oktober 2008, 

ANYER, BANTEN 

6 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Pemetaan Prediksi Lokasi Mineral 

Uranium Dengan Citra Landsat 7 

ETM+ (Studi Kasus : Kabupaten 

Ketapang, Kalimantan Barat) 

29-30 Oktober 2008, 

ANYER, BANTEN 

7 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Aplikasi Teknologi Penginderaan 

Jauh dan Sistem Informasi 

Geografis Untuk Pemantauan 

Tutupan Lahan dan Kualitas 

Lingkungan Kabupaten Sidoarjo 

Dampak Lapindo. 

29-30 Oktober 2008, 

ANYER, BANTEN 

8 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Pemetaan Prediksi Lokasi Mineral 

Uranium Dengan Citra Landsat 7 

ETM+ (Studi Kasus : Kabupaten 

Ketapang, Kalimantan Barat) 

29-30 Oktober 2008, 

ANYER, BANTEN 

9 Knowledge-Sharing, 

Ikatan Surveyor 

Indonesia 

Product Development Sampai 

Dengan Aplikasi Penggunaan 

Alat.Survei 

29 Nov 2008, Bandung 

10 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 
Indonesia (MAPIN) 

Studi Perbandingan Suhu 

Permukaan Laut Menggunakan 

Citra Satelit NOAA-AVHRR Dengan 

Argo Float di Perairan Selatan 

Jawa, Bali dan Nusa Tenggara 

10 Desember 2008, 

Bandung 

11 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Studi Perbandingan Suhu 

Permukaan Laut Dari Data Citra 

Modis Dengan Argo Float di 

Selatan Jawa-Bali 

10 Desember 2008, 

Bandung 

12 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Pemanfaatan Band Thermal 

Infrared (TIR) Citra Aster Untuk 

Pemetaan Suhu Permukaan Laut di 

Perairan Selat Madura 

10 Desember 2008, 

Bandung 

13 Talk Show dan 

Seminar Nasional 

Ikatan Surveyor 

Indonesia dan 

Himpunan Ahli Tanah 

Identifikasi Tanaman Padi Dengan 

Mengkonversi Data Radian ke Data 

Reflektan Pada Citra Aster (Studi 

Kasus Kabupaten Subang) 

4 Maret 2009, Bandung 



 

 Indonesia   

14 Talk Show dan 

Seminar Nasional 

Ikatan Surveyor 

Indonesia dan 

Himpunan Ahli Tanah 

Indonesia 

Analisa Potensi Lahan Pertanian 

Dengan Menggunakan Teknologi 

Penginderaan Jauh dan Sistem 

Informasi Geografis di Kabupaten 

Tabanan dan Badung Bali. 

4 Maret 2009, Bandung 

15 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Sejarah dan Perkembangan 

Penginderaan Jauh di Indonesia 

10-11 Nopember 2010, 

Pakanbaru 

16 Seminar Nasional ITS 

dan KLH 

Monitoring Pengaruh Pembuangan 
Lumpur Sidoarjo di Kali Porong 

Menggunakan Citra Satelit 

16 Maret 2011 

Surabaya 

17 Simposium Nasional 

ITS 

Pemanfaatan Data Spasial Dalam 
Perkembangan Teknologi 

Pertambangan di Indonesia 

23 Maret 2011 

Surabaya 

18 Seminar Nasional ITS, 

HAGI (Himpunan 

Ahli Geofisika 

Indonesia) dan BP 

Migas. 

Pengembangan Kompetensi Ilmu 

dan Teknologi kebumian di ITS 

28 – 29 April 2011 
Surabaya 

19 Seminar Nasional 

Implementasi Undang 

Undang Informasi 

Geospasial 

(UUIG) 

Prospek Perkembangan Keilmuan 

dan Teknologi Dalam Rangka 

Menunjang Implementasi UUIG 

Terutama Untuk Data dan 

Informasi Geospasial Tematik 

6 – 7 Juni 2011 
Yogyakarta 

20 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Pembuatan Sistem Informasi 

Bangunan Cagar Budaya Berbasis 

WebGIS (Studi Kasus : Kota 

Surabaya) 

8 Juni 2011, Semarang 

21 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Studi Perubahan Suhu Permukaan 

Laut Menggunakan Satelit 

AquaModis 

8 Juni 2011, Semarang 

22 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Studi Deformasi Gunung Merapi 

Menggunakan Teknologi 

Interferometri Sysnthetic Aperture 

Radar (InSAR) 

8 Juni 2011, Semarang 

23 Pertemuan Ilmiah 

Tahunan XVII (PIT 

XVII) Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

Studi Perubahan Bidang Tanah 

Akibat Bencana Alam Gunung 

Merapi Ditinjau Dari Aspek Hukum 

Agraria 

8 Juni 2011, Semarang 

24 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Peran dan Fungsi Pendidikan 

Tinggi Geospasial Di Wilayah 

Perbatasan Dalam Rangka Menjaga 

Kedaulatan Negara Kesatuan 

24 Nopember 2011 

Semarang 



 

  Republik Indonesia (NKRI)  

25 Lokakarya Integrasi 

Data dan Informasi 

Geospasial Kelautan 

Nasional Guna 

Mendukung MP3EI 

Badan Informasi 

Geospasial (BIG) 

Pembangunan Sistem Informasi 

Transportasi Laut untuk Analisa 

Strategi Transportasi Laut Guna 

Mendorong Jasa Industri Nasional 

Berbasiskan Pada WebGIS (Studi 

Kasus Wilayah Gerbangkertasusila 

Plus) 

5 September 2012, 

Bogor, Indonesia 

26 Forum Ilmiah 

Tahunan : Informasi 

Geospasial Bagi 

Pengelolaan Sumber 

Daya Alam dan 

Pembangunan 

Ekonomi, Ikatan 

Surveyor Indonesia 

Pembangunan Sistem Informasi 

Transportasi untuk Analisa Strategi 

Transportasi Guna Mendorong Jasa 

Industri Nasional Berbasiskan Pada 

WebGIS (Studi Kasus Wilayah 

Gerbangkertasusila Plus) 

17 Oktober 2012, 

Jakarta, Indonesia, 

27 Seminar Nasional dan 

Call Paper “Integrasi 

Kebijakan dan 

Penguatan Industri 

Nasional Menuju 

Percepatan dan 

Perluasan Ekonomi 

Indonesia” Jurusan 

Ekonomi 

Pembangunan 

Universitas Negeri 

Semarang 

Pembangunan Sistem Informasi 

Transportasi Untuk Analisa Strategi 

Transportasi Guna Mendorong Jasa 

Industri Nasional Berbasiskan Pada 

WebGIS (Studi Kasus Wilayah 

Gerbangkertasusila Plus) 

30 Oktober 2012, 

Semarang 

28 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

STUDI PEMBUATAN SISTEM 

INFORMASI KELAUTAN 

BERBASIS WEB (STUDI KASUS 

WILAYAH PESISIR DAN 

PANTAI SELAT MADURA) 

31 Oktober 2013 

Yogyakarta 

29 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

PENENTUAN LOKASI 

BUDIDAYA RUMPUT LAUT 

MENGGUNAKAN 

SATELIT TERRA MODIS 

DI DAERAH PESISIR JAWA 

TIMUR 

31 Oktober 2013 

Yogyakarta 

30 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

ANALISIS DAN EVALUASI 

PERUBAHAN GARIS PANTAI 

DAN TATA GUNA LAHAN DI 

KAWASAN PESISIR 

31 Oktober 2013 

Yogyakarta 

31 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Pembangunan Sistem Informasi 

Transportasi Untuk Analisa 

StrategiTransportasi Guna 

Mendorong Jasa Industri Nasional 

Berbasiskan Pada WebGIS (Studi 

31 Oktober 2013 

Yogyakarta 



 

  Kasus Wilayah Gerbangkertasusila 

Plus) 

 

32 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

Inventarisasi Dan Pemetaan 

Biodiversity (Keanekaragaman 

Hayati) 

Ekosistem Mangrove Di Jawa 

Timur Dengan Menggunakan 

Teknologi Penginderaan Jauh Dan 

Berbasis WebGIS. 

31 Oktober 2013 

Yogyakarta 

33 Forum Ilmiah 

Tahunan Ikatan 

Surveyor Indonesia 

ANALISA PERBANDINGAN 

KONSENTRASI KLOROFIL 

ANTARA CITRA SATELIT 

TERRA DAN AQUA/MODIS 

DITINJAU DARI SUHU 

PERMUKAAN LAUT DAN 

MUATAN PADATAN 

TERSUSPENSI 

(Studi Kasus : Perairan Selat 

Madura dan sekitarnya) 

31 Oktober 2013 

Yogyakarta 

34 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

APLIKASI PENGINDERAAN 

JAUH UNTUK ANALISA 

PERUBAHAN POLA ALIRAN 

DAN DAERAH GENANGAN DI 

PESISIR SURABAYA-SIDOARJO 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

35 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

ANALISA KONSENTRASI 

MUATAN PADATAN 

TERSUSPENSI MENGGUNAKAN 

CITRA SATELIT LANDSAT 7 

ETM+ DAN LANDSAT 8 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

36 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

PEMODELAN MATEMATIKA 

ANTARA DATA 

KEPENDUDUKAN DENGAN 

KERAPATAN BANGUNAN 

MENGGUNAKAN CITRA 

QUICKBIRD (STUDI KASUS 

KECAMATAN DUKUH PAKIS 

DAN KECAMATAN 

SUKOMANUNGGAL) 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

37 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

ANALISA KESESUAIAN 

KONDISI PERAIRAN DI MUARA 

KALI PORONG 

MENGGUNAKAN PARAMETER 

KONSENTRASI KLOROFIL DAN 

SEBARAN TOTAL SUSPENDED 

SOLID DENGAN METODE 

PENGINDERAAN JAUH (Studi 

Kasus: Pesisir Pantai Surabaya- 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 



 

  Sidoarjo)  

38 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

ANALISIS TINGKAT 

KEKERUHAN AIR 

MENGGUNAKAN ALGORITMA 

JING LI, BUDIMAN DAN 

LEMIGAS PADA CITRA TERRA 

ASTER DI PERAIRAN SELAT 

MADURA 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

39 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

ANALISA MULTI KRITERIA 

UNTUK MENENTUKAN 

DAERAH KERENTANAN 

DAERAH ALIRAN SUNGAI 

BENGAWAN SOLO DI 

KABUPATEN LAMONGAN 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

40 Seminar Nasional 

AplikasiTeknologi 

PrasaranaWilayah 

(ATPW) 

ANALISA INDEKS VEGETASI 

UNTUK EKOSISTEM 

MANGROVE DENGAN 

MENGGUNAKAN CITRA 

LANDSAT 8 (Studi Kasus: Wilayah 

Pesisir Kota Surabaya) 

18 Juni 2014, 
ISSN 2301-6752, 

Surabaya 

41 Musyawarah 

Nasional XV, 

Forum Ilmiah 

Tahunan Ikatan 

Surveyor 

Indonesia, 

Analisis Pengaruh Tutupan Lahan 

Terhadap Ketelitian ASTER GDEM 

V2 dan DEM SRTM V4.1 

(Studi Kasus: Kota Batu, Kabupaten 

Malang, Jawa Timur) 

22 Oktober 2014 

ISBN978-602-71616- 

0-3 

Bandung 

42 Musyawarah 

Nasional XV, 

Forum Ilmiah 

Tahunan Ikatan 

Surveyor 

Indonesia, 

Studi Persebaran Klorofil-a 

Menggunakan Citra Aqua MODIS 

dan Landsat 8 di Pantai Surabaya– 

Sidoarjo Dampak Lumpur Lapindo 

22 Oktober 2014 

ISBN978-602-71616- 

0-3 

Bandung 

43 Musyawarah 

Nasional XV, 

Forum Ilmiah 

Tahunan Ikatan 

Surveyor 

Indonesia, 

PEMETAAN GEOLOGI SKALA 

1:50000 DENGAN 

MENGGUNAKAN CITRA 

RADARSAT 2 DAN LANDSAT 8 

(Studi Kasus : Nangapinoh Provinsi 

Kalimantan Barat) 

22 Oktober 2014 

ISBN978-602-71616- 

0-3 

Bandung 

44 Musyawarah 

Nasional XV, 

Forum Ilmiah 

Tahunan Ikatan 

Surveyor 

Indonesia, 

Analisa Estimasi Produksi Padi 

Berdasarkan Fase Tumbuh dan 

Model Peramalan Autoregressive 

Integrated Moving Average 

(ARIMA) Menggunakan Citra 

Satelit Landsat 8 

(Studi Kasus: Kabupaten 

Bojonegoro) 

22 Oktober 2014 

ISBN978-602-71616- 

0-3 

Bandung 



 

    

45 Rapat Koordinasi 

PPIDS Se- 

Indonesia BIG- 

ITS 

Informasi Pusat Studi Infrastruktur 

Data Spasial (PSISD) – ITS 

5 Nopember 2014 

Surabaya 

46 Simposium 

Nasional Teknik 

Geodesi 

Jurusan Teknik 

Geodesi FTSP- 

ITS, BIG, ESRI 

Prospek dan Tantangan Pusat Studi 

Infrastruktur Data Spasial Dalam 

Pengembangan Potensi Daerah 

19 Nopember 2014 

Surabaya 

47 SEMINAR NASIONAL 

TEKNIK SIPIL 

XI-2015 

ANALISA KUALITAS 

LINGKUNGAN HIDUP 

BERDASARKAN HUBUNGAN 

BIOFISIK (UDARA) 

DENGAN TUTUPAN LAHAN 

BERBASIS WEB (Studi Kasus : 

Surabaya Selatan) 

28 Januari 2015, 

Surabaya 

48 SEMINAR NASIONAL 

TEKNIK SIPIL 

XI-2015 

Analisa Hasil Pengolahan Citra 

TerraSAR-X dan Landsat 8 Untuk 

Pemetaan Geologi Lembar 

Mojokerto (1508-62) Jawa Timur 

28 Januari 2015, 

Surabaya 

49 Pertemuan Ilmiah 

Tahunan (PIT) 

Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

2014 

ANALISA KUALITAS 

LINGKUNGAN UDARA 

BERDASARKAN KEPADATAN 

LALU LINTAS DENGAN 

MENGGUNAKAN METODE 

SISTEM INFORMASI 

GEOGRAFIS BERBASIS WEB 

(Studi Kasus : Surabaya Pusat) 

5-6 Pebruari 2015, 

Bogor 

50 Pertemuan Ilmiah 

Tahunan (PIT) 

Masyarakat 

Penginderaan Jauh 

Indonesia (MAPIN) 

2014 

STUDI PENENTUAN POLA 

PERSEBARAN KLOROFIL-A 

DAMPAK LUMPUR SIDOARJO 

MENGGUNAKAN CITRA 

SATELIT 

NOAA-AVHRR (Studi Kasus : 

Pantai 
Surabaya Sidoarjo) 

5-6 Pebruari 2015, 

Bogor 

51 The 2nd ISST 2016- 
International Seminar 

on Science and 2016 

The analysis of Surface 

Temperature Anomalies at Arjuno- 

Welirang Geothermal Prospects 

Using Multitemporal Thermal 

Infrared (TIR) Remote Sensing Data 

ITS Surabaya, 2 
August 2016 

52 INTERNATIONAL 

CONFERENCE : 

Jogja Earthquake in 

Reflection 

COMMEMORATING 

10 YEARS OF 

YOGYA KARTA 

ANALYSIS OF SATELLITE 

IMAGES LANDSAT NDVI 

MULTI-TEMPORAL FOR 

MONITORING 

DEFORESTATION OF THE 

FOREST NORTH ACEH 

REGENCY 

15-16 Pebruari 2016, 

Yogyakarta 



 

 EARTHQUAKE, 
2016 

  

53 Departement of 

Geomatics National 

Cheng Kung 

University Tainan 

Taiwan 2017 

Remote Sensing for Monitoring 

Paddy Field 

10-12 Mei 2017, 
Tainan, Taiwan 

 

G. Pengalaman Penulisan Buku dalam 5 Tahun Terakhir 

 

No. Judul Buku Tahun Jumlah 

Halaman 

Penerbit 

1 Penginderaan Jauh (ISBN 978-602-9494-23-5) 2012 113 ITS Press 

2 Toponimi (ISBN 978-602-9494-23-6) 2012 103 ITS Press 

3 Hitung Proyeksi Geodesi (ISBN 978-602-0917-10-8) 2014 164 ITS Press 

4 Sistem Informasi Geografis (Teori dan Aplikasi 
(ISBN 978-602-0917-45-0) 

2015 208 ITS Press 

 

H. Pengalaman Perolehan HKI Dalam 5 � 10 Tahun Terakhir 

 

No. Judul/Tema HKI Tahun Jenis Nomor P/ID 

1     

2     

3     

 

I. Pengalaman Merumuskan Kebijakan Publik/Rekayasa Sosial Lainnya Dalam 5 

Tahun Terakhir 

 

No. Judul/Tema/Jenis Rekayasa 

Sosial Lainnya yang Telah 

Diterapkan 

Tahun Tempat 

Penerapan 

Respons 

Masyarakat 

1 Standardisasi Informasi Data 
Spasial 

2008-2010 Indonesia Baik 

2 Undang Undang Informasi 
Geospasial 

2010-2011 Indonesia Baik 

3 Grand Design Survei Dasar Dan 
Sumber Daya Alam (Pemetaan 

Tematik Nasional) 

2011 Indonesia Baik 

4 Grand Design Pemetaan Tematik 

Nasional) dan Peningkatan Data dan 

Informasi Batas Wilayah 

2011 Indonesia Baik 

5 Penyusunan Standar Kompetensi 
Kerja Nasional Indonesia (SKKNI) 

2013 Indonesia Baik 

 

J. Penghargaan yang Pernah Diraih dalam 10 tahun Terakhir (dari pemerintah, 

asosiasi atau institusi lainnya) 



 

No. Jenis Penghargaan Institusi 

Pemberi 

Penghargaan 

Tahun 

1 Dwidya Satya Perdana (20 tahun) Presiden 

Republik 

Indonesia 

10 Nopember 
2003 

2 Dwidya Satya Madya (25 tahun) Rektor ITS 
Surabaya 

10 Nopember 
2008 

3 Satyalencana Karya Satya Karya 20 Tahun Presiden 

Republik 

Indonesia 

24 Juli 2009 

4 Dwidya Satya Utama (30 tahun) Rektor ITS 
Surabaya 

10 Nopember 
2013 

5. Lencana Pancawarsa Ketua Kwartir 

Nasional Gerakan 

Pramuka 

3 Agustus 
2006 

 

Semua data yang saya isikan dan tercantum dalam biodata ini adalah benar dan dapat 

dipertanggungjawabkan secara hukum. Apabila di kemudian hari ternyata dijumpai 

ketidaksesuaian dengan kenyataan, saya sanggup menerima risikonya. 

Demikian Curriculum Vitae ini saya buat dengan sebenarnya. 

Surabaya, 20 

Nopember 2017 

Pengusul, 

 

 

 

 

(Prof.Dr.Ir. Bangun Muljo Sukojo,DEA,DESS) 
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Informatic Engineer with 1.5 year experience. Just recently gained master degree from 

Institute Technology Bandung (ITB) in Bandung, Indonesia with major in Information 

System. Having a Bachelor Degree in Informatics Engineering from Sepuluh Nopember 

Institute of Technology (ITS) in Surabaya, Indonesia. 

 

 Key Experience  

 Business/System Analyst 

 Software Tester 

 Business/System and Software Documentation 

 Database Administrator 

 Web Designer 

 Web Administrator 

 Teaching 
 

 Professional Qualifications  
 

Qualification Institution Year 

Master Degree in Information System Bandung Institute of Technology (ITB), 

Bandung, Indonesia 

2013 

Bachelor Degree in Informatics 

Engineering 

Sepuluh Nopember Institute of 

Technology (ITS), Surabaya, Indonesia 

2007 

 
 Career Summary (Total Experience: 2 years)  

 

Employer Designation Period 

STT YPM Sidoarjo Freelance Lecturer 
February 2014 - 

Present 

PT. Industri Kereta Api (INKA), 

Madiun, Indonesia 
Database Administrator 

Sept 2009 – Feb 

2010 

PT. Suryasoft Konsultama, Surabaya, 

Indonesia 

Junior Consultant 

(Business/System Analyst) 

Jan 2008 – July 

2008 
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Cempaka Ananggadipa Swastyastu, S.Kom, MT. 

Engineer 

Jl. Teknik Geodesi P-5, Perum ITS Sukolilo 

Surabaya 60111 Indonesia 

dipa.swastyastu@yahoo.com 

+62-81-7370178 (mobile) 

+62-31-5932370 (res) 

mailto:dipa.swastyastu@yahoo.com
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PT. Kabel Vision, Surabaya, Indonesia Web Developer 
June 2004 – 

August 2004 

 

 Work Experiences  

 

Sekolah Tinggi Teknik YPM, Sidoarjo, Indonesia Feb 2014 - Present 

High Education Institution (University)  

Freelance Lecturer  

 
 Teaching in Informatics Engineering Department 

 
 

PT. Industri Kereta Api (INKA), Madiun, Indonesia Sept 2009 – Feb 2010 

National Train Manufacture Company  

Database Administrator  

 
 Monitoring Company Database 

 Database Maintenance 

 Documentation 
 

 

PT. Suryasoft Konsultama, Surabaya, Indonesia Jan 2008 – July 2008 

Software Development and IT Consultant Company  

Junior Consultant  

 

 Software Testing 

 Business/System Analyzing 

 Documentation 
 
 

PT. Kabel Vision, Surabaya, Indonesia June 2004 – August 2004 

Cable TV Company  

Web Developer  

 
 Website Administrator 

 Web Developing 

 Web Maintenance 

 

 Computer Skills  
 

 ArcMap 

 ER Mapper 

 Rational Rose 
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 ENVI 

 Ulead Photo Impact 

 Arena 

 Macromedia Dreamweaver 

 Sybase PowerDesigner 

 MS SQL Server 

 MS Access 

 MS Office 
 

 Organization Experience  
 

 

Name 
 

Position 
 

Year 

1
st
 Information Technology Scientific Papers 

Training, Information Technology Faculty, Sepuluh 

Nopember Institute of Technology Surabaya 

Program Section 

Member 

2003 

Freshman Admission Committee of Information 

Technology Faculty Sepuluh Nopember Institute of 

Technology Surabaya 

Structural Committee 2003 

Organization Committee 2002 

Student Association of Computer Engineering - 

Informatique Department, Sepuluh Nopember 

Institute of Technology Surabaya 

Member of Section V : 

Art and Sport Activity 

Section 

2001- 

2002 

Graduation Banquet of Information Technology 

Faculty, Sepuluh Nopember Institute of Technology 

Surabaya 

Consumption Member 2001 

Program Section Chief 2002 

High School Journal SMUN2 Surabaya Human Relation Staff 1999 

High School Journal SMUN 2 Surabaya Reporter and 

Photographer 

1998- 
2000 

 

 Courses and Seminars  
 

No Name Place Dates 

1 Information and 

Communication Technology 

Seminar 

Graha ITS, Surabaya August 2005 

2 IT Entrepreneur Seminar Graha Pena Surabaya 26 February 

2003 
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3 English Regular Program, 

Basic - Advance Level 

YPIA Surabaya 1998-2001 

4 Regular TOEFL Program, 

Advance Level 

YPIA Surabaya 2004 

5 French Extensive Program, 

Intermediate - Advance Level 

CCCL Surabaya 2001-2004 

6 DELF (Diplôme d’Etudes en 

Langue Française) pour 

Premier Level (A1-A4) 

CCCL Surabaya September 2005 

7 DELF (Diplôme d’Etudes en 

Langue Française) pour 

Premier Level (B2) 

CCCL Surabaya 2007 

 

 Personal Data  

Date of Birth : 18
th

 April 1983 

Nationality : Indonesian 

Languages known : English, Indonesian, French 

Interests : Reading, Travelling, Swimming, Water Sport, Cooking, Listening Music 

 

 
------- 
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3.21 

SALWA NABILAH 

Institut Teknologi Sepuluh Nopember 

Department of Geomatics Engineering 2013 

 
Address : Campurejo 13/04, Panceng, Gresik, East Java 61156 

D-o-B : Lamongan, December 23rd 1995 

Phone : +62 82 234002176 

Email : snabilah18@yahoo.co.id | salwa13@mhs.geodesy.its.ac.id 

About me : I define myself as a person who is a fast learner, adaptive, 

patient, and not easily give up. I have a dream to be able help Indonesia 

improve the competitiveness and accelerate commonweal. 

Jobdesk : Administration Staff 
 

 

 

1. External & Internal Affair 

JMMI ITS (ITS Islamic Student Executive Board) as Staff Member of Internal Division 

2. External Affair 

JMMI ITS (ITS Islamic Student Executive Board) as Girl’s Head of Internal Division 

3. Geomatics Islamic Study Division 

HIMAGE ITS (Students Association of Geomatics) as Secretary of the Division 
 

 

1. Organizing Committee of GERIGI ITS 2014 

2. Organizing Committee of Pre Basic LKMM Training FTSP ITS 2014 

3. Organizing Committee of Islamic Program Study 1 Training JMMI ITS 2015 

4. Pre Basic LKMM Training FTSP ITS 2013 

5. Scientific Papers Training HIMAGE ITS 2013 

6. Emotional Spiritual Quotient (ESQ) Training ITS 2013 

7. Islamic Program Study 1 Training JMMI ITS 2014 
 

 
 

1. Internship with Title “REMOTE SENSING APPLICATIONS AND GEOGRAPHIC INFORMATION 

SYSTEMS IN CONSENTRATION OF TSS (TOTAL SUSPENDED SOLID) USING MODIS 
IMAGE (Case Study: Madura Strait and Lampung Bay January-May 2016)” 2016 at LAPAN Jakarta 

2. Research Project with Title “ESTIMATION ANALYSIS OF RICE PRODUCTIVITY WITH 

LANDSAT 8 IMAGE BASED ON PHASE GROW, IN-SITU EQUIPMENT AND 
AUTOREGRESSIVE FORMULATION MODEL INTEGRATED MOVING AVERAGE (ARIMA) 
(Case Study: Bojonegoro Regency)” 2017 at Geospatial Laboratory of Geomatics Engineering ITS 

Surabaya 

3. Research Project with Title “THE ACCURACY ANALYSIS OF ORTHOREKTIFIKASI IMAGE OF 

THE PLEIADES AND QUICKBIRD FOR MAKING BASED MAP OF PLAN DETAILING THE 
GREEN OPEN SPACES IN THE DEVELOPMENT OF SPATIAL DATA INFRASTRUCTURE 

(Case Study: Part of Tuban Urban Area)” 2017 at Geospatial Laboratory of Geomatics Engineering ITS 
Surabaya 

 

 

 

ArcGIS | ER Mapper | PCI Geomatica | BILKO | 

Global Mapper | Matlab | ENVI | BEAM VISAT | ESA 
SNAP | Topcon Tools 

 
TEFL 

 
GPA 

 
 

Salwa Nabilah sabilfahim salwaaa2312 Salwa Nabilah 

Scale of 
4.0 

ITS 
TEFL 

mailto:snabilah18@yahoo.co.id
mailto:salwa13@mhs.geodesy.its.ac.id


 

 

 

 

CURRICULUM VITAE 
 

NAME : Dhiyaulhaq Al Majid 

PLACE AND DATE OF BIRTHDAY : Jakarta, 1 July 1995 

SEX : Male 

ADDRESS : Gang Makam No.21, Keputih, Sukolilo, Surabaya East Java 

Indonesia 

PHONE : 08979748603 

GPA : 3.22 ( Scale 4.00) 

TOEFL SCORE 477 

EMAIL : dhiyaulhaqmajid@gmail.com 

JOBDESK : Coordinator of Geospatial Data Inventory 
 
 
 

Formal Educational Background 

School Place Year 

University Geomatics Engineering Department at 

Sepuluh Nopember Institute of Technology 

2013 – 2017 

Senior High School SMA Negeri 42 Jakarta 2010 - 2013 

Junior High School Mts Negeri 6 Jakarta 2007 - 2010 

SKILL 

Computer Programs Surveying Instrument 

Microsoft Office Total Station 

AutoCAD Land Desktop 2009 Theodolite 

Topcon Tools 8.23 Waterpass 

ArcGIS GPS Geodetic 

Matlab GPS Navigasi 
Surfer  

Global Mapper  

MicroSurvey CAD 2002  

 

Seminar , Non Formal Education Training and Work Experience 

Description Place Year 

AUTOCAD Training Surabaya , Sepuluh Nopember 

Institute of Technology 

2014 

ArcGIS Basic Training Surabaya , Sepuluh Nopember 

Institute of Technology 

2015 

Measurement of long cross section 

Pipeline Wastewater treatment plant 

Design 

Sebatik Island, Nunukan North 

Borneo 

2016 

Measurement Detail Survey Claket 

Village District 

Pacet, Mojokerto East Java 2016 

Staking Out Drag Race Design Glora 

Bung Tomo 

Surabaya, East Java 2015 

Measurement of topography Pandaan, Sidoarjo, East Java 2016 

Tidal Measurements Teluk Lamong, Surabaya 2015 

mailto:dhiyaulhaqmajid@gmail.com


 

CURRICULUM VITAE 

Nama : Izhad Miftachurrozaq 

Tempat / tgl lahir : Surabaya / 13 November 1994 

Jenis Kelamin : Laki-laki 

Agama : Islam 

Alamat : Jl. Wonorejo Asri III / A3 Wisma Indah, 

Kel. Wonorejo, Kec.Rungkut, Surabaya. 

No HP : 088226225855 

Email : izhadmift@gmail.com 
 
 

*Jobdesk : Operator Inventarisasi Data Geospasial 

Riwayat Pendidikan: 

1. SD Muhammadiyah 4 Surabaya (2001-2007) 

2.   SMPN 19 Surabaya (2007-2010) 

3. SMAN 2 Surabaya (2010-2013) 

4. Sarjana Teknik (S1) Departemen Teknik Geomatika (2013-2017) 

Institut Teknologi Sepuluh Nopember Surabaya 

Judul Tugas Akhir: “Pemodelan Pola Sebaran Sedimen 

Untuk Analisis Dampak Reklamasi Terhadap Pendangkalan 

Di Teluk Benoa Bali” 

IPK : 3,14 
 

Pengalaman Pekerjaan: 

1. Surveyor (2015) 

PT. Maerakaca Graha Kencana 

Melakukan koordinasi dan pengumpulan data pada pekerjaan 

Konsultan Advisory Kelembagaan, pada Satuan Kerja 

Pengembangan Air Minum dan Sanitasi Provinsi Jawa Timur, 

Direktorat Jenderal Cipta Karya, Kementerian Pekerjaan Umum 

dan Perumahan Rakyat. 

 
2. Kerja Praktik / Magang : 

PT. Pelabuhan Indonesia III (Persero) (2016) 

Ast. Geodetic Engineer 

(Survey Batimetri kolam pelabuhan, Survey Topografi, 

Pengolahan data dan Penyajian Peta Batimetri) 
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mailto:izhadmift@gmail.com


 

Keahlian Bidang dan Software: 

1. LAND SURVEYING 

Survey / pengukuran dan pemetaan terestris. 

Alat: Theodolite / Total Station, GPS Geodetic, Waterpass 

Software: AutoCAD, MicroSurvey CAD, Surfer 

 
2. HYDROGRAPHY 

Survey / pengukuran dan pemetaan kedalaman laut serta pengamatan pasang surut 

air laut. 

Alat: Single Beam Echosounder 

Software: HYPACK 

 
3. REMOTE SENSING AND GIS (Penginderaan Jauh dan Sistem Informasi Geografis) 

Pengolahan data citra satelit dan penyajian peta. 

Software: ENVI, ArcGIS, Global Mapper, MapSource, GoogleEarth 

 
4. OCEANOGRAPHY 

Pemodelan Hidrodinamik (Arus, Sedimen, Pasang Surut) 

Software: MIKE, Delft3D, SMS 

 
Software tambahan: 

Microsoft Office, Corel Draw, Adobe Photoshop 

Pengalaman Pelatihan: 

 
 
 
 

Pengalaman Organisasi dan Kepanitiaan: 

1. Himpunan  Mahasiswa Teknik Geomatika ITS (2014-2015) 

Staff Fungsionaris Departemen Dayacipta Kreasi Mahasiswa 

2. Malam Akrab Fakultas Teknik Sipil dan Perencanaan ITS (2014) 

Panitia 

3. Simposium Nasional 2015 (2015) 

Panitia 

4. Earth Day – Geo Collaboration (2015) 

Wakil Ketua Panitia 

5.   Geolympic 2016 (2016) 

Panitia 

6.   Dies Natalis Ikatan Mahasiswa Geodesi Indonesia (2016) 

Panitia 
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1. Latihan Keterampilan Manajemen Mahasiswa – PRA TD (2013) 

2. Studi Pemahaman Tarbiyah Islam  (2013) 
3. Pelatihan Software ArcGIS  (2015) 
 



 

 
 

 

MUHARRAMA 

PUTRA PRAYOGA 

OPERATOR TEKNIS BASIS DATA GEOSPASIAL 

 

 

 

 

BIODATA 

 

Jakarta, 14 Juni 1995 
 

Perumahan Kalidonan no. 

64 CIlacap 

 
 
 

PENDIDIKAN 

PENGALAMAN ORGANISASI 
 

Pengurus OSIS SMP Islam Al-Azhar 15 Cilacap 

Pengurus Patroli Keamanan Sekolah SMA Negeri 1 Cilacap 

Staff Pengembangan Sumber Daya Mahasiswa HIMAGE-ITS 

Kepala Biro Pemetaan Pengembangan Sumber Daya Mahasiswa 

HIMAGE-ITS 

 

SD Islam A-Azhar 16 Cilacap 

SMP Islam Al-Azhar 15 Cilacap 

SMA Negeri 1 Cilacap 

Teknik Geomatika ITS Surabaya 

PENGALAMAN PANITIA 

 

Young Engineering Summit (YES Summit) 2014 

Young Engineering Summit (YES Summit) 2015 

Simposium Nasional 2015 

GEOICON 2016 

Seminar & Workshop Implementation FPPLA in Indonesia 2016 

Seminar & Workshop MySurv - HI TARGET 2017 

 



 

KEAHLIAN SOFTWARE 
 

ArcGIS ENVI 

BEAM VISAT 

AutoCAD MATLAB 

Topcon Tools 



 

 

 

PENGALAMAN PEKERJAAN 

 
Survei Pemetaan Topografi Pakuwon City, Surabaya 2013 

Survei Pemetaan Detail Situasi Dalam Rangka Penyusunan Outline Plan dan DED 

Sistem Pengolahan Air Limbah, Teluk Wondama 2016 Survei Pemetaan Irigasi 

Tersier, Trenggalek 2017 

Survei Pengukuran Beda Tinggi Dalam Rangka Perbaikan Paving & Saluran Air, 

Surabaya 2017 

Pemateri Pelatihan Software Dalam Rangka Inventaris Data Spasial, Tuban 2017 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 



 

PANDUAN INVENTARISASI DATA SPASIAL 

PENATAAN RUANG KABUPATEN TUBAN 

 

 

 

 

KERJA SAMA  

ANTARA 

BADAN PERENCANAAN PEMBANGUNAN DAERAH KABUPATEN TUBAN 

DENGAN  

BADAN PENGEMBANGAN DAN PENGELOLA USAHA  

INSTITUT TEKNOLOGI SEPULUH NOPEMBER SURABAYA 

 

 

 

NOMOR : 188.45 /1278/414.201/2017 

NOMOR : 043465/IT2.VIII/KS.00.00/2017 

 

 

 

 

 

 

 

 

 

 



 

Inventarisasi Data Spasial Penataan Ruang 
1. MELAKUKAN KONVERSI DATA GEOSPASIAL DENGAN METODE DIGITASI 

ON-SCREEN 

Proses digitasi onscreen dilakukan untuk mengubah data raster menjadi data vektor. Proses ini dapat 

dilakukan pada komputer dengan perangkat lunak SIG maupun CAD. Data utama yang diperlukan 

adalah data raster yang bisa berupa citra satelit ataupun peta yang sudah di-scan. Selain itu diperlukan 

pula informasi seputar koordinat titik-titik referensi sebagai acuan pendefinisian koordinat geografis. 

1.1.1 Georeferensi Data Raster 

Sebelum dikonversi menjadi data vektor melalui digitasi onscreen, data raster haruslah digeoreferensi 

terlebih dahulu. Proses georeferensi secara umum dibagi menjadi 2 tahap yaitu input koordinat titik-

titik ikat dan pendefinisian sistem koordinat. 

1.1.1.1 Input Koordinat Titik Ikat 

 Untuk membuka data raster yang akan didigitasi, klik ikon Add Data   dan carilah data 

raster yang akan didigit (dalam hal ini contohnya peta RBI Lembar 1608-444). 

 

 Akan muncul warning Unknows Spatial Reference. Hal ini wajar karena data raster yang 

diberikan memang sama sekali belum memiliki referensi koordinat. Klik OK, selanjutnya peta 

yang diinginkan tampak di layar. 

 

 Selanjutnya untuk melakukan input titik kontrol, klik ikon Add Control Points  lalu klik pada 

peta titik-titik yang koordinatnya sudah diketahui (dalam hal ini adalah pojok-pojok muka peta). 

Perhatikan gambar berikut: 



 

 

 Kemudian lakukan klik kanan dan pilih Input X and Y... untuk memasukkan koordinat titik ikat. 

Pada peta RBI, koordinat Y ditulis mendatar dan X ditulis menyamping. 

 

 Lakukan hal yang sama untuk titik-titik ikat lainnya. Pada contoh ini menggunakan 4 titik ikat 

yang ditempatkan pada pojok muka peta. 

 

 

 

 

 Selanjutnya klik ikon Open Link Table untuk melihat hasil georeferensi: 



 

 

 Selanjutnya klik Georeferencing > Rectify untuk mengoreksi data raster menjadi data 

berkoordinat: 

 

 

 Isikan nama file dan folder penyimpanan. Format data raster baru ini adalah TIFF. Lalu klik Save. 

1.1.1.2 Pendefinisian Sistem Koordinat Data Raster 

Setelah data raster diberikan koordinat tidak serta merta ia sudah tergeoreferensi. Perlu dilakukan 

pendefinisian satuan, proyeksi, dan datum atau ellipsoid referensi pada peta raster tersebut. Untuk 

melakukannya dilakukan lewat ArcCatalog.  

 Jalankan program ArcCatalog dari Start Menu Windows, kemudian carilah file data raster yang 

telah diberikan koordinat hasil georeferencing tadi. 



 

 

 Lalu klik kanan pada file tersebut, dan pilih Properties. Pada tab General cari bagian Spatial 

Reference. 

 

 Klik Edit pada bagian tersebut (Spatial Reference) lalu pilih tipe koordinat yang digunakan dalam 

data tersebut (dalam hal ini data peta RBI tersebut menggunakan proyeksi UTM Zona 49 S 

dengan ellipsoid referensi DGN 1995).  

 Pilih Projected Coordinate System > UTM > Indonesia > DGN 1995 UTM Zone 49S. Lalu 

klik OK. 

 



 

 

 Terlihat bahwa sekarang nilai koordinat yang terdapat pada Extent merujuk pada nilai 

koordinat proyeksi UTM Zona 49S dengan ellipsoid referensi DGN 1995. Selanjutnya pada 

jendela Properties tadi, klik OK.  

 

 Dengan demikian data raster tersebut sudah berkoordinat dan memiliki referensi spasial yang 

jelas.  

 

1.1.2 Digitasi Data Raster 

Data raster yang sudah digeoreferensi selanjutnya siap untuk didigitasi. Sebelum digitasi dimulai, 

maka pastikan layer yang akan didigitasi sudah disiapkan dalam format shapefile (*.shp). 

1.1.2.1 Menyiapkan Shapefile Layer 

Untuk membuat layer shapefile baru dilakukan melalui program ArcCatalog.  



 

 Jalankan program ArcCatalog, kemudian carilah folder tempat data raster tersebut disimpan: 

 

 Setelah berada pada folder tersebut, untuk membuat layer shapefile baru klik kanan dan pilih 

New > Shapefile: 

 

 Kemudian pada jendela Create New Shapefile isikan nama layernya (misalnya jalan_lokal) 

dan tipe data spasialnya (feature type: titik, garis, atau poligon): 

 

 Pada bagian Spatial Reference klik tombol Edit untuk memilih sistem koordinat layer 

tersebut, dalam hal ini contohnya DGN 1995 UTM Zona 49S. Kemudian pilihlah sistem 

koordinat yang digunakan dalam data raster tersebut. Lalu klik OK. 



 

 

 Bila layer/shapefile tersebut sudah memiliki deskripsi nama, tipe, dan sistem koordinat yang 

lengkap, maka klik OK untuk membuat shapefile tersebut. Dengan cara yang sama kita dapat 

membuat layer shapefile untuk objek bertipe titik maupun poligon. 

 

 

1.1.2.2 Mendigit dan Mengedit Data Spasial 

Sebelum mulai melakukan digitasi onscreen, terlebih dahulu data raster yang akan didigit beserta 

layer yang akan didigit dimuat dahulu ke dalam workspace ArcGIS.  

 Jalankan program ArcMap, lalu klik ikon Add Data  dan muat semua data raster dan 

data shapefile yang akan dipakai dalam proses digitasi. 



 

 

 Gunakan data raster yang sudah berformat tiff. Setelah diload, data-data yang digunakan akan 

tampak pada layar: 

 

 Proses digitasi data raster berarti juga termasuk proses editing shapefile layer yang 

bersangkutan. Proses editing data ini dilakukan pada sesi editing tersendiri. Caranya melalui 

menu Editor >> Start Editing yang dapat diakses melalui toolbar Editor.   

 

 Selanjutnya ketika pengguna sudah berada pada sesi editing, proses edit data spasial bertipe 

titik, garis, maupun poligon dapat dilakukan. 



 

 Untuk memilih unsur/layer mana saja yang akan diedit, munculkan jendela editing Create 

New Feature. Caranya melalui menu Editor >> Editing Windows >> Create Features. 

 

 Selanjutnya daftar unsur spasial/layer yang dapat diedit dimunculkan dalam jendela Create 

Features. 

 

 Manakala hendak menambahkan objek pada layer tertentu, pengguna tinggal mengklik layer 

tersebut. 

 Bila pengguna sudah selesai mengedit unsur-unsur spasial tersebut dan menyimpan 

perubahannya, pengguna dapat mengklik menu Editor >> Save Edits. Setelah itu pengguna 

dapat mengakhiri sesi editing dengan menu Editor >> Stop Editing. 

  



 

1.2 Melakukan Editing Data Geospasial 

  

1. BATASAN VARIABEL 

2. Konteks Variabel 

Unit ini berlaku untuk mempersiapkan dan melaksanakan editing data, membangun hubungan 

antar unsur geospasial serta menyusun laporan pekerjaan, yang digunakan untuk melakukan 

editing data geospasial pada pemrosesan data geospasial. 

3. Peralatan dan perlengkapan untuk melakukan editing data geospasial, mencakup tidak terbatas 

pada:   

3.1. Peralatan 

3.1.1. Perangkat keras komputer 

3.1.2. Perangkat lunak SIG 

3.1.3. Printer dan plotter 

 

3.2. Perlengkapan 

3.2.1. Kertas 

3.2.2. Alat tulis 

4. Peraturan yang diperlukan untuk melakukan editing data geospasial, meliputi: 

4.1. UU No. 4 tahun 2011 tentang Informasi Geospasial 

4.2. PP No. 8 tahun 2013 tentang Ketelitian Peta Rencana Tata Ruang 

5. Norma dan standar untuk melakukan editing data geospasial, meliputi: 

5.1. SNI ISO 19113:2011 Informasi Geografis – Prinsip Kualitas 

5.2. Manual/petunjuk penggunaan perangkat keras dan perangkat lunak SIG 

5.3. Aturan dan etika profesi sesuai dengan yang berlaku di masyarakat profesi, utamanya 

bidang geospasial (asosiasi profesi dan instansi terkait lainnya) 

 

6. PANDUAN PENILAIAN 

1. Konteks penilaian 

1.1. Kondisi penilaian merupakan aspek dalam penilaian yang sangat berpengaruh atas 

tercapainya kompetensi ini terkait dengan melakukan editing data geospasial. Untuk itu, 

pengujian harus dilakukan secara konsisten pada seluruh elemen dan dilaksanakan pada 

situasi pekerjaan yang sebenarnya ditempat kerja atau secara simulasi dengan kondisi 



 

seperti tempat kerja normal dengan menggunakan kombinasi metode uji untuk 

mengungkap pengetahuan, keterampilan dan sikap kerja sesuai dengan tuntutan standar.  

1.2. Penilaian dapat dilakukan dengan cara: lisan, tertulis, demonstrasi/praktik, dan simulasi di 

workshop dan/atau di tempat kerja, dan atau di Tempat Uji Kompetensi (TUK). 

2. Persyaratan Kompetensi 

Unit kompetensi yang harus dikuasai sebelumnya: 

2.1. M.711000.129.01 : Melakukan Konversi Data Geospasial dengan Metode Digitasi 

On-Screen 

2.2. M.711000.128.01 : Melakukan Konversi Data Geospasial dengan Metode Meja 

Digitasi 

3. Pengetahuan dan keterampilan yang diperlukan: 

3.1. Pengetahuan tenang sistem koordinat geospasial 

3.2. Pengetahuan tentang sistem transformasi koordinat geospasial 

3.3. Ketrampilan perangkat lunak SIG 

3.4. Pengetahuan tentang perangkat keras komputer 

3.5. Pengetahuan SNI terkait digitasi, editing grafis dan atribut, ketelitian peta, dan metadata 

informasi geospasial 

4. Sikap kerja yang diperlukan: 

4.1. Kemampuan bekerja sama dalam tim 

4.2. Kemampuan bekerja sistematis 

5. Aspek kritis 

Aspek kritis yang perlu diperhatikan dalam kompetensi ini, adalah:  

5.1. Ketelitian dan kecermatan dalam mempersiapkan pekerjaan 

5.2. Ketelitian dan kecermatan dalam melaksanakan pekerjaan 

5.3. Ketelitian dan kecermatan kontrol kualitas hasil pekerjaan 

 

1.Melakukan Editing Data Spasial  

1.2.1 Editing Data Shapefile Tipe Point 

1.2.1.1 Membuat dan menghapus objek 

Semisal hendak menambahkan objek baru pada layer bertipe point, langkah-langkahnya adalah: 

 Pada jendela Create New Feature klik layer yang akan diedit 

 Lalu klik pada tampilan SIG di lokasi mana objek/data tersebut akan ditambahkan 



 

 

 Untuk menghapus objek yang sudah ada, klik ikon Edit Tool ( ) pada toolbar Editor 

(ikon ini berfungsi untuk memilih objek yang akan diedit). Lalu klik pada objek yang akan 

dihapus, kemudian tekan tombol Delete. 

 

1.2.1.2 Membuat titik dengan koordinat tertentu 

 Untuk membuat objek titik pada koordinat tertentu, ketika proses editing sedang berlangsung, 

klik kanan pada tampilan peta SIG  

 Pilih menu Absolute X, Y. Selanjutnya isikan koordinat titik baru. Lalu tekan Enter. 

 

 

1.2.1.3 Membuat titik berimpit dengan objek tertentu 



 

Untuk membuat objek dapat berimpit dengan objek lainnya secara tepat, perlu diaktifkan Snapping 

terlebih dahulu.  

 Caranya dengan memunculkan toolbar snapping melalu menu Editor >> Snapping >> 

Snapping Toolbar.  

 Lalu aktifkan pilihan snapping objek yang diinginkan. Umumnya ada 4 jenis snapping yang 

sering digunakan: Point, Endpoint, Vertex, Edge. 

 
 

 

 

 
 

 Dengan mengaktifkan snapping tersebut, objek yang akan ditambahkan/digambar dapat 

berimpit pada objek lain yang sudah ada. 

1.2.1.4 Menggeser posisi objek titik 

 Untuk menggeser posisi suatu objek titik, cukup pilih titik yang akan dipindah, lalu digeser ke 

posisi barunya. 

 

 
1.2.2 Editing Data Shapefile Tipe Line 

1.2.2.1 Membuat dan menghapus objek 

 Untuk membuat objek polyline baru, pada jendela Create Feature klik pada layer bertipe line.  

Kemudian gambarkan objek pada peta SIG.  

 Lakukan klik ganda pada titik terakhir untuk menyelesaikan penggambaran objek baru. 

edge vertex 
point endpoint 



 

 
 

 

 Kemudian untuk menghapus objek garis caranya sama dengan menghapus objek point, yaitu 

dengan memilih objek yang akan dihapus kemudian tekan tombol Delete. 

1.2.2.2 Menggabungkan 2 atau lebih objek menjadi satu 

Beberapa objek garis yang sebenarnya saling bersambung dapat dijadikan menjadi satu garis saja.  

 Caranya dengan memilih unsur-unsur garis yang akan digabungkan. Hal ini dilakukan dengan 

mengklik ikon Edit Tool. 

 Tekan dan tahan tombol Shift sambil mengklik pada objek yang akan digabungkan. Setelah 

objek-objek tersebut terpilih, pada menu Editor (di toolbar Editor) pilih Merge. 



 

 
 

 Dikarenakan 2 atau lebih objek yang digabungkan bisa saja memiliki atribut yang berbeda, 

maka atribut objek hasil penggabungan hanya dapat mengikuti salah satu atribut objek yang 

digabungkan.  

 

 Pilih salah satu objek yang atributnya akan dijadikan acuan atribut untuk objek baru, lalu klik 

OK. 

 

1.2.2.3 Memisahkan garis menjadi beberapa objek/segmen 

Sebuah objek garis dapat dibagi menjadi beberapa segmen. Panjang segmen hasil pembagian dapat 

ditentukan berdasarkan persentase panjang objek asli, jumlah segmen, atau nilai panjang tertentu.  

 Pilih objek garis yang akan dibagi, lalu pilih menu Editing >> Split. 



 

 
 

 

 Pada contoh ini, segmen garis dibagi menjadi 3 bagian yang sama panjangnya (pilihan Into 

Equal Parts). 

1.2.2.4 Menambah simpul dan menghaluskan bentuk objek 

Kadang-kadang segmen garis yang terdiri dari beberapa simpul memiliki bentuk yang kaku. Untuk 

menghaluskan objek tersebut diperlukan simpul-simpul tambahan agar objek semakin luwes 

dibentuk.  

 Caranya pilih objek yang akan diedit dengan Edit Tool. Lalu klik ganda pada objek tersebut. 

Ketika simpul titik objek ditampilkan, klik kanan dan pilih Insert Vertex. 

      

 Dengan simpul yang lebih banyak, bentuk objek semakin mudah untuk diubah agar lebih halus. 

Caranya dengan menggeser simpul objek tersebut sehingga bentuk yang diinginkan tercapai. 

1.2.2.5 Menyederhanakan objek 



 

Kadangkala ada objek yang seharusnya digambarkan dengan simpul yang sedikit, tetapi malah 

memiliki simpul yang terlalu banyak. Misalnya pada objek garis lurus. Objek ini sebaiknya 

disederhanakan bentuknya.  

 Aktifkan toolbar Advanced Editing lewat menu Editor >> More Editing Tools >> Advanced 

Editing.  

 

 Lalu klik pada objek yang akan disederhanakan, selanjutnya klik ikon Generalize ( ). Lalu 

masukkan jumlah offset yang diinginkan (misalnya 2). 

 

 
 

1.2.3 Editing Data Shapefile Tipe Polygon 

1.2.3.1 Membuat dan menghapus objek 

 Untuk membuat objek polygon baru, pilih layer bertipe polygon pada jendela Create Features.  

 Lalu gambarkan objek yang diinginkan pada peta.  

 Lakukan klik ganda pada titik terakhir objek yang digambar. 

 

 
 

 Untuk menghapus objek poligon, dapat dilakukan dengan cara yang sama seperti sebelumnya. 

 



 

 

1.2.3.2 Menggabungkan 2 atau lebih objek 

Beberapa polygon dapat digabungkan menjadi satu objek. Caranya sama seperti yang dilakukan pada 

objek bertipe polyline (lihat contoh sebelumnya) yaitu dengan menu Merge. 

 

1.2.3.3 Membentuk ulang objek 

Objek poligon dapat dibentuk ulang bila dirasa masih belum sesuai dengan kondisi di lapangan. 

Caranya sama seperti objek bertipe polyline, yaitu dengan menambahkan simpul (vertex) pada tepian 

objek. Selanjutnya simpul-simpul tersebut dapat digeser untuk membentuk ulang objek. 

      

1.2.3.4 Membagi objek 

Pilih objek yang akan dibagi dengan Edit Tool. Lalu klik ikon Cut Polygons Tool ( ) pada 

toolbar Editor. Kemudian gambarkan garis bagi objek melintasi objek poligon yang akan dibagi 



 

 

1.2.3.5 Auto Complete Polygon 

Autocomplete Polygon berguna untuk membuat poligon baru yang berimpit dengan poligon yang 

sudah ada, tanpa harus menggambar sisi poligon baru secara keseluruhan. Jadi sisi poligon yang 

sudah ada tidak perlu digambarkan lagi.  

 Cara menggunakan fasilitas ini melalui klik ikon Create Features ( ) , lalu pada Listbox 

Construction Tools, pilih Auto Complete Polygon. 

 

 Kemudian pilih poligon di mana poligon baru akan memiliki sisi yang berimpitan (bisa lebih dari 

1 poligon). Lalu gambarkan sisi poligon baru dimulai dari sisi poligon yang sudah ada. 

 

1.2.3.6 Reshape Feature 

Fitur Reshape Feature berguna untuk membentuk ulang poligon menjadi lebih luas atau lebih sempit. 

Fasilitas ini cara kerjanya mirip dengan Auto Complete Polygon. Hanya saja tidak menambah jumlah 

poligon.  

 Cara menggunakannya adalah pilih poligon yang sudah ada yang akan diperluas atau 

dipersempit. Lalu klik ikon Reshape Feature Tool ( ). Kemudian gambarkan bagian sisi 

poligon yang baru. 



 

  

 Garis yang membentuk ulang poligon dapat digambarkan di luar poligon, atau memotong poligon 

di dalam. Bila garis digambarkan di luar poligon, maka luas poligon bertambah. Bila garis 

digambarkan di dalam poligon, maka luas poligon berkurang dan hanya menyisakan bagian 

terbesar dari poligon yang di-reshape. 

 
1.2.4 Editing Data Atribut 

Setiap objek dalam layer SIG memiliki informasi atribut yang mendeskripsikan objek tersebut. 

Atribut setiap layer dapat dilihat, ditambahkan, dikurangi, atau diganti sesuai keperluan. 

1.2.4.1 Menampilkan tabel data atribut 

Setiap layer shapefile, baik yang bertipe point, polyline, maupun polygon pasti memiliki satu tabel 

atribut tersendiri. Jumlah record pada tabel pasti sama dengan jumlah objek yang terdapat pada layer 

tersebut. Bila kriteria ini tidak terpenuhi karena suatu hal, maka shapefile tersebut tidak dapat 

digunakan.  

 Untuk memunculkan tabel atribut layer, klik kanan layer yang dimaksud pada jendela Table Of 

Contents, lalu pilih Open Attribute Table: 

 

 Selanjutnya tabel atribut dari layer yang bersangkutan dimunculkan: 



 

 

1.2.4.2 Mengedit record data 

 Untuk mengedit record data pada tabel, pengguna harus memasuki sesi editing terlebih dahulu. 

Setelah itu pengguna memilih objek/record mana yang akan diedit atributnya, cukup dengan 

melakukan klik pada cell tabel yang akan edit isinya. 

 

1.2.4.3 Menambah dan menghapus kolom tabel 

Kolom atau field pada tabel merupakan isian tentang deskripsi tertentu pada setiap record. Kolom 

dapat dihapus atau ditambahkan hanya bila sedang di luar sesi editing.  

 Untuk menambahkan kolom, klik ikon Table Options ( ) , lalu pilih Add Field.... Akan 

muncul kotak dialog keterangan jenis data yang akan disimpan pada field baru tersebut: 

 



 

 Isikan nama kolom pada Name, pilih jenis data pada Type. Isian jenis data bisa berupa bilangan 

bulat (short & long integer), bilangan desimal (float), bilangan desimal double precision (double), 

tanggal (date), atau teks biasa (text). Untuk isian data bertipe float dan double, isikan juga jumlah 

angka yang dapat ditampung (precision) dan jumlah angka di belakang koma (scale). Lalu klik 

OK. 

 

 Untuk menghapus field, klik pada nama field sehingga seluruh kolom tersebut diblok (diwarnai 

biru muda). Lalu klik kanan dan pilih Delete Field. Pengguna akan dimintai konfirmasi apakah 

benar-benar ingin menghapus field tersebut (Yes) atau tidak (No). Field yang sudah dihapus 

tidak apat dikembalikan lagi, kecuali dengan membuat dan mengisikan datanya satu per satu 

kembali. 

1.2.5 Menampilkan atau Mengatur Peta 

1. Tampilkan file AcehbesarKec, AcehBesarRoad, AcehBesarSungai. 

2. Klik kanan pada AcehbesarKec > Properties > Symbology. Atau klik dua kali pada file yang 

dipilih. 

3. Pilih Categories > Unique Values. 

4. Pilih NAMA_KEC pada kolom Value Field. 

5. Klik Add Values, pilih Darussalam. 

 



 

 

6. Pindahkan ke Layout View dengan klik View > Layout View. Atau klik ikon di bagian bawah 

halaman data. 

 
7. Setelah mengganti ke Layout View, maka peta akan disajikan pada halaman layout. Halaman 

layout ini menyajikan satu atau lebih data frame. 



 

 
1. Layout toolbar memuat tools yang dipakai untuk mengedit layout. 

Tools tersebut antara lain zoom in, zoom out, pan dan beberapa tools 

standar lain. 

 

Keterangan 

 Zoom in/Zoom out : Memperbesar atau memperkecil peta pada layer yang aktif di halaman 

layout. 

 Pan : Menggerakkan peta pada layer yang aktif di halaman layout. 

 Fixed zoom in/zoom out : Memperbesar atau memperkecil peta pada layer yang aktif dengan 

skala yang diberikan langsung oleh ArcMap. 

 Zoom Whole Page : Menampilkan seluruh halaman layout. 

 Zoom 100% : Menampilkan peta yang aktif dengan skala 1:1. 

 Go to next extent/previous extent : Ke tampilan peta sebelum atau sesudah. 

 Zoom control : Menampilkan peta dengan skala perbesaran yang diinginkan pengguna. 

 Toggle Draft mode : Digunakan untuk membuat layout tanpa tampilan peta, sehingga pengguna 

tidak perlu menunggu gambaran peta. Pada toggle draft mode, peta diwakili dengan judul layer. 

 Focus data frame : Untuk fokus pada salah satu data frame. 

 Change layout : Untuk mengubah layout. Pengguna dapat memilih template peta yang 

diinginkan. 

Perlu dicatat bahwa setiap project di ArcGIS hanya dapat menyajikan satu layout. 



 

1.2.5.1 Mengatur Proyeksi 

1. Klik kanan pada layer yang aktif, lalu klik Properties > Data Frame Properties > Coordinate 

System. 

2. Akan muncul kotak Data Frame Properties > Coordinate System. 3. Pada Kotak Select a 

coordinate system, pilih Predefined > Projected Coordinate System > UTM > WGS1984 

UTM Zone 46N 

 

1.2.5.2 Mengatur Halaman Layout 

1. Untuk mengatur lebar halaman. Klik kanan halaman pada halaman layout lalu pilih Page and 

Print Setup. Akan muncul kotak Page and Print Setup 



 

 

2. Langkah yang lain adalah dengan meng-klik menu view > Page and Print Setup. Kemudian 

akan muncul kotak dialog Page and Print Setup. 

 

3. Kotak dialog Page and Print Setup digunakan untuk mengubah orientasi portrait menjadi 

landscape atau sebaliknya. Ukuran halaman dapat diubah dengan mengeditnya di kotak 

properties. 



 

 

4. Elemen-elemen penting lain yang wajib dicantumkan pada sebuah peta, antara lain adalah skala, 

legenda, panah penunjuk arah, judul dan koordinat peta. 

4.1.1.1 Langkah-langkah untuk Menambahkan Koordinat Peta 

1. Klik kanan pada data frame, pilih Properties 

 
2. Atau ke menu View > Data Frame Properties. 



 

 

3. Kotak dialog Data Frame Properties > Grids > New Grid. 

 
4. Selanjutnya akan muncul kotak dialog Grids and Graticules Wizard. Kotak dialog Grid and 

Graticules Wizard akan membimbing pengguna melewati 4 tahap untuk melengkapi peta 

dengan garis koordinat dan koordinatnya. Pada tahap pertama pengguna akan memilih jenis 

koordinat dan garis koordinat yang diinginkan. Klik Next. 



 

 
5. Tahap kedua akan membimbing pengguna untuk membuat garis koordinat dan menentukan 

interval garis koordinat pada peta. Atur interval koordinat pada 2 menit, bila Anda merasa 

interval terlalu rapat ubah dengan interval yang lebih besar. Klik Next. 

 
6. Tahap ketiga adalah untuk mengedit label koordinat dan garis koordinat. Atur ukuran huruf 

menjadi 8, dengan mengubah di kotak text style. Atau sesuaikan uran huruf sesuai yang Anda 

inginkan. Klik Next. 



 

 

7. Tahap keempat untuk membuat batas kotak koordinat pada peta. Setelah selesai, klik Finish. 

 
4.1.1.2 Langkah-langkah untuk Menambahkan Skala 

1. Klik Insert > Klik Scale Bar untuk menambahkan skala. 



 

 

2. Kotak dialog Scale Bar Selector akan muncul. Skala dapat diedit dengan mengklik Properties. 

 

3. Pilih bentuk skala yang diinginkan, dan klik OK. 

4. Klik skala dan tarik ke halaman yang kosong pada halaman layout. 

5. Pengguna juga dapat menambahkan skala teks. Klik Insert > Scale Text. 



 

 
6. Lalu akan muncul kotak Scale Text Selector. 

7. Teks skala dapat diubah dengan memilih Properties. Setelah pengguna memilih jenis skala yang 

diinginkan, klik Ok. 

4.1.1.3 Langkah-langkah untuk Menambahkan Panah Penunjuk Arah 

1. Klik Insert > North Arrow. 

 
2. Selanjutnya kotak dialog North Arrow Selector akan muncul. Panah penunjuk arah dapat diedit 

dengan mengklik tombol Properties. 

3. Pilih Panah penunjuk arah yang diinginkan, lalu klik Ok. 

4. Klik panah penunjuk arah, tarik ke halaman kosong di halaman layout. 



 

 

4.1.1.4 Langkah-langkah untuk Menambahkan Judul Peta 

1. Klik menu Insert > Title. 

 
2. Tulis judul yang mewakili peta pada kotak judul. Untuk mengubah bentuk dan ukuran judul 

sesuai kebutuhan, klik kanan pada kotak judul dan pilih Properties. Setelah itu akan muncul 

kotak Properties. Ketiklah judul pada kolom text yang telah disediakan. 



 

 

4.1.1.5 Menambahkan Object pada Layout 

1. Klik Insert > Object. 

 
2. Akan muncul kotak Insert Object. User dapat memilih tipe objek yang akan di tampilkan pada 

layout. Bila objek gambar telah ada, klik Create From File, dan pilih objek yang ingin 

ditampilkan pada layout. 



 

 
3. Letakkan objek pada halaman layout kosong. 

4.1.1.6 Menambahkan Teks pada Layout 

1. Klik Insert > Text. 

 
2. Kemudian akan muncul kotak teks pada halaman layout. Klik kanan pada kotak teks tersebut, 

pilih Properties. Akan muncul kotak Properties. 



 

 
3. Tulis teks untuk ditampilkan pada layout peta. Untuk mengatur jenis tulisan klik Change 

Symbol, maka selanjutnya akan muncul kotak dialog Symbol Selector. 

 
4. Klik Ok. 

 

4.1.1.7 Langkah-langkah untuk Menambahkan Legenda 

1. Klik menu Insert > Legend 



 

 

2. Kotak dialog Legend Wizard akan muncul. Kotak ini akan membimbing pengguna melalui 5 

tahap dalam membuat legenda sesuai dengan yang diinginkan.  

1. Tahap pertama akan membimbing pengguna untuk memilih data-data yang ingin ditampilkan 

pada kotak legenda. Pilih data yang diinginkan untuk ditampilkan di kotak legenda. Klik Next. 

 
2. Tahap kedua membimbing pengguna untuk membuat judul legenda sesuai dengan yang 

diinginkan. 



 

 
3. Tahap ketiga adalah untuk membuat kotak legenda sesuai yang diinginkan pengguna. Klik 

menu drop down border untuk menambah bingkai kotak legenda. Pilih border garis hitam 

dengan ketebalan 3, klik menu drop down backdround untuk memilih warna latar. Pilih warna 

latar olive.  

 
4. Tahap keempat untuk mengedit ukuran dan bentuk lambang yang mewakili setiap data sesuai 

yang diinginkan pengguna. Misalnya, lambang untuk data persil dapat diubah ukurannya dan 

bentuknya menjadi oval, lingkaran atau kotak.  



 

 
5. Tahap terakhir membimbing pengguna untuk menentukan jarak antara bagian-bagian yang 

disajikan pada legenda peta. Klik Finish setelah menyelesaikan Legend Wizard. 

 

Berikut contoh tampilan layout yang telah selesai. 



 

 

4.1.1.8 Menyimpan Peta 

Untuk menyimpan peta baru, klik menu File > Save As. Atau dengan meng-klik ikon . Peta dapat 

disimpan dalam ekstensi mxd dan mxt. Ekstensi mxd adalah untuk menyimpan peta dalam bentuk 

dokumen project, sedangkan ekstensi mxt untuk menyimpan peta dalam bentuk template. 

 



 

4.1.1.9 Ekspor Peta 

Klik menu File > Export Map. Peta dapat diekspor ke berbagai macam format, seperti PDF, JPEG, 

TIFF, dan lain-lain. 

 
9.14. Mencetak Peta 

1. Klik File > Print 

 
2. Kotak Print akan muncul. Setup cetak dapat disesuaikan dengan meng-klik Setup > OK. 

3. Maka akan tampil kotak dialog Print untuk memilih printer, ukuran kertas dan kualitas cetakan. 



 

 

Google Maps 
Google Maps adalah layanan mapping online yang disediakan oleh google secara gratis. Layanan ini 

dapat diakses melalu situs http://maps.google.com. Pada situs tersebut kita dapat melihat informasi geografis 

pad hampir semua wilayah di bumi. Layanan ini interaktif,karena di dalamnya peta dapat digeser seusia 

keinginan pengguna,mengubah tingkat zoom, serta menggubah tampilan peta. Fasilitas yang terdapat pada 

Google Maps antara lain adalah menjelajah peta, mencari lokasi tertentu, seperti hotal,tempat hiburan, lokasi 

bisnis, dan menghitung rute dalam berkendara.  Tampilan yang akan muncul pada situs Google Maps adalah 

sebagai berikut 



 

 

Google Maps API 
Google Maps juga dapat digabungkan dengan website. Penambahan tersebut dilakukan dengan 

menggunakan fitur Google Maps API,dimana fitur tersebut merupakan library JavaScript. Membuat Google 

Maps API membutuhkan pengetahuan tentang HTML dan JavaScript, serta koneksi Internet. Dengan 

menggunakan Google Maps API kita dapat menghemat waktu dan biaya untuk membangun aplikasi peta 

digital yang handal, sehingga kita dapat fokus pada data yang hendak ditampilkan dan diolah. Google Maps 

juga dapat digabungkan dengan bebeberapa bahasa pemprograman lain seperti PHP, PERL, CGI dan 

sebagainya. 

  Gambar-gambar peta yang muncul pada layar merupakan hasil komunikasi dari pengguna dengan 

database pada web server google untuk menampilkan gabungan dari potonga-potomgan gambar yang 

diminta. Keseluruhan citra yang ada diintegrasikan ke dalam suatu database pada Google Server, yang 

nantinya akan dapat dipanggil sesuai kebutuhan permintaan.  

Untuk memulai menggunakan Google Map API kita memerlukan beberapa perintah program. Yang pertama, 

kita bisa mulai menulis program Google Map API dengan urutan sebagai berikut:  

 1. Memasukkan Maps API JavaScript ke dalam HTML kita.  

 2. Membuat element div dengan nama map_canvas untuk menampilkan peta.  

 3. Membuat beberapa objek literal untuk menyimpan property-properti pada peta.  

 4. Menuliskan fungsi JavaScript untuk membuat objek peta.  

 5. Meng-inisiasi peta dalam tag body HTML dengan event onload.  



 

Semisal kita ingin menampilkan kota Depok di file HTML saya (di dalam komputer saya saja) pada tag div 

berukuran 600 pixel x 600 pixel. Kita bisa menjalankan urutan di atas. Beginilah kode program dasarnya:  

 

Perhatikan urutan langkah-langkahnya yang saya tuliskan dalam komentar HTML dan JavaScript kode HTML di 
atas.  

Google Maps API Key 
Perhatikan baris ini:  

 

Kode yang dicetak tebal dan berwarna merah adalah Google Maps API key. Anda harus mendaftar 

untuk mendapatkan key untuk website Anda, jika Anda ingin menampilkan peta untuk website Anda. Setelah 

mendaftar, termasuk memberikan alamat website Anda, Google akan memberi Anda sebuah API key. 

Bentuknya kurang lebih seperti ini (tentu saja milik Anda nantinya akan berbeda):  
ABQIAAAA8tt4eKTuBZMVnLJfP2BZrBT2yXp_ZAY8_ufC3CFXhHIE1NvwkxS4Rz1LFzG0odNPtk8VLkdrQ

F5grA  

Key yang digunakan di atas digunakan untuk computer local (pendaftaran didaftarkan untuk alamat 
localhost). Jadi, jika ingin mencoba menulis program untuk dijalankan di computer sendiri, sementara bisa 
memakai key ini. Nanti kalau program sudah siap, baru perlu mendaftar sendiri API key, kemudian dipakai 
menggantikan API key contoh dari saya.  

<html>  

<head>  

<meta name="viewport" content="initial-scale=1.0, user-scalable=no" />  

 

<!-- Langkah 1 -->  

<script type="text/javascript" 

src="http://maps.google.com/maps/api/js?sensor=true&amp;key=ABQIAAAA8tt4eK

TuBZMVnLJfP2BZrBT2yXp_ZAY8_ufC3CFXhHIE1NvwkxS4Rz1LFzG0odNPtk8VLkdrQF5grA">

</script>  

<script type="text/javascript">  

 

// Langkah 4  

function initialize() {  

var latlng = new google.maps.LatLng(-6.4, 106.8186111);  

var myOptions = {  

zoom: 13,  

center: latlng,  

mapTypeId: google.maps.MapTypeId.ROADMAP  

};  

 

// Langkah 3  

var map = new google.maps.Map(document.getElementById("map_canvas"), 

myOptions);  

}  

</script>  

</head>  

 

<!-- Langkah 5 -->  

<body onload="initialize()">  

 

<!-- Langkah 2 -->  

<div id="map_canvas" style="width:600px; height:600px"></div>  

 

</body>  

</html>  

 

<script type="text/javascript" 

src="http://maps.google.com/maps/api/js?sensor=true&amp;key=ABQIAAAA8tt4e

KTuBZMVnLJfP2BZrBT2yXp_ZAY8_ufC3CFXhHIE1NvwkxS4Rz1LFzG0odNPtk8VLkdrQF5grA

"></script>  

 



 

Parameter sensor berisi true (berwarna hijau) digunakan untuk menggunakan sensor lokasi , misalnya 
GPS (jika ada, misalnya jika aplikasi web based kita diakses dengan ponsel tertentu yang memiliki GPS).  

Elemen peta pada tag div  
Pada baris ini:  

<div id="map_canvas" style="width:600px; height:600px"></div>  

Kita menentukan lebar tag div adalah 600px, dan lebar juga 600px, dengan style CSS. Ukuran peta yang 
ditampilkan akan selalu mengikuti ukuran yang Anda tentukan pada tag tersebut.  

Setting peta  
Kita menentukan setting peta pada baris program ini:  

var latlng = new google.maps.LatLng(-6.4, 106.8186111);  

var myOptions = {  

zoom: 13,  

center: latlng,  

mapTypeId: google.maps.MapTypeId.ROADMAP  

};   

Telah diberikan lokasi Latitude dan Longitude pusat kota Depok, yaitu -6,4 dan 106.8186111. Untuk 
kota lainnya dapat dicari dulu lokasinya berdasarkan Latitude dan Longitude. Informasi bisa didapatkan dari 
dari situs ConvertUnits.com untuk mengetahui berapa latitude dan longitude suatu lokasi. Parameter zoom 

menentukan zoom level yang diinginkan. Semakin kecil nilainya, semakin jauh jarak pandang Anda dari tanah. 
Nilai 0 akan menunjukkan peta seluruh dunia. Nilai maksimal adalah 19. 
Parameter mapTypeId menentukan jenis peta yang akan ditampilkan. Pilihannya ada 4: 

1. ROADMAP, untuk menampilkan peta biasa 2 dimensi 

2. SATELLITE, untuk menampilkan foto satelit 

3. TERRAIN, untuk menunjukkan relief fisik permukaan bumi dan menunjukkan seberapa tingginya 

suatu lokasi, contohnya akan menunjukkan gunung dan sungai 

4. HYBRID, akan menunjukkan foto satelit yang diatasnya tergambar pula apa yang tampil pada 

ROADMAP (jalan dan nama kota) 

Terdapat 3 kelompok lagi jenis peta yang bisa dipakai, mereka adalah: 
• Kelompok Google Map Maker, peta-peta dalam kategori ini merupakan kontribusi dari seluruh dunia 

• Kelompok peta Celestial, selain peta bumi, Google juga menyediakan peta bulan, dan Mars 

• Kelompok peta 3D, membutuhkan plugins Google Earth. 

Menampilkan peta pada tag div 
Di atas, kita telah membuat fungsi initialize(). Fungsi ini menampilkan peta Google Maps pada tag div 

dengan id map_canvas. Masalahnya adalah, peta tidak akan muncul jika fungsi ini tidak dipanggil. Maka, 
fungsi ini akan dipangil pada event onload, ketika semua object sudah siap, termasuk JavaScript Google Maps 
API sudah terdownload sepenihnya oleh browser. Pemanggilan tersebut terjadi pada baris ini: 

<body onload="initialize()"> 

Interaksi dengan peta 
Interaksi dengan peta Google Maps API bisa dilakukan dengan beberapa cara, diantaranya dengan method-
method seperti: setCenter(), panTo() dan zoomIn(). Selain method, Google Maps API juga mendukung event 
listener. 

Code Snippet  

Menampilkan peta sederhana  

Berikut ini diberikan contoh, bagaimana menampilkan peta sederhana kota Palo Alto di mana Google berada. 
Peta ini ditampilkan tanpa Control dan Marker. Hanya peta.  



 

 

 

Menambahkan 10 Marker secara random di kota Depok  

Berikut di berikan contoh bagaimana menampilkan kota Depok dan menambahkan 10 Marker yang lokasinya 
acak. Ini ditujukan agar Anda mendapat gambaran bagaimana menambahkan Marker standar di atas peta. 

 

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")); 

map.setCenter(new GLatLng(37.4419, -122.1419), 13);  

}  

}  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")); 

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

 

// Add 10 markers to the map at random locations  

var bounds = map.getBounds();  

var southWest = bounds.getSouthWest();  

var northEast = bounds.getNorthEast();  

var lngSpan = northEast.lng() - southWest.lng();  

var latSpan = northEast.lat() - southWest.lat();  

for (var i = 0; i < 10; i++) {  

var point = new GLatLng(southWest.lat() + latSpan * Math.random(),  

southWest.lng() + lngSpan * Math.random()); 

map.addOverlay(new GMarker(point));  

}  

}  

} 



 

Membuat peta yang berpindah dari Depok ke Palo Alto setelah 1 detik  
Berikut ini contoh membuat peta yang dapat beranimasi, berpindah dari Depok kemudian pindah ke Palo 
Alto. Ini bukanlah contoh yang baik. Untuk implementasi yang baik, sebaiknya pindah ke lokasi yang dekat 
saja dan bertahap. Screenshot tidak diberikan karena tidak menggambarkan animasi.  

Menampilkan windows info di atas peta  

Menampilkan window info di atas peta  

 
 

 

Event: Menampilkan alert ketika user mengklik peta  
Contoh program berikut ini menunjukkan bagaimana menangkap event click kemudian melakukan proses 
sederhan, yaitu menampilkan alert.  
 

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

window.setTimeout(function() {  

map.panTo(new GLatLng(37.4569, -122.1569));  

}, 1000);  

}  

}  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")); 

map.setCenter(new GLatLng(-6.4, 106.8186111), 13); 

map.openInfoWindow(map.getCenter(),  

document.createTextNode("Hello, world"));  

}  

}  

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

GEvent.addListener(map, "click", function() {  

alert("You clicked the map.");  

});  

}  

} 

 



 

 
 

 

Event: Menampilkan alert posisi tengah peta yang baru setelah drag selesai  
Contoh program berikut menunjukkan penggunaan event moveend. Ketika akhir drag, baru aksi tertentu 
dijalankan.  

 



 

 

 

 

Event: Menambahkan 5 titik di peta yang masing-masing menampilkan potongan 

pesan rahasia jika diklik  
Kode program berikut berfungsi menyimpan 5 potong pesan yang kemudian dipasang pada window Info 5 
buah Marker yang diletakkan secara acak.  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.81861119), 13); 

GEvent.addListener(map, "moveend", function() {  

var center = map.getCenter();  

alert(center.toString());  

});  

}  

}  

 



 

 

 

Event: Menampilkan window info berisi latitude, longitude dan zoom level ketika 

peta diklik  
Dalam program berikut, kita menangkap event klik pada peta, kemudian menampilkan window Info berisi 
latitude, longitude dan zoom level pada lokasi tempat pengguna mengklik.  

 

function initialize() {  

var message = ["This","is","the","secret","message"];  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

 

// Creates a marker at the given point  

// Clicking the marker will hide it  

function createMarker(latlng, number) {  

var marker = new GMarker(latlng);  

marker.value = number;  

GEvent.addListener(marker,"click", function() {  

var myHtml = "<b>#" + number + "</b><br/>" + message[number -1];  

map.openInfoWindowHtml(latlng, myHtml);  

});  

return marker;  

}  

 

// Add 5 markers to the map at random locations  

// Note that we don't add the secret message to the marker's instance data  

var bounds = map.getBounds();  

var southWest = bounds.getSouthWest();  

var northEast = bounds.getNorthEast();  

var lngSpan = northEast.lng() - southWest.lng();  

var latSpan = northEast.lat() - southWest.lat();  

for (var i = 0; i < 5; i++) {  

var latlng = new GLatLng(southWest.lat() + latSpan * Math.random(),  

southWest.lng() + lngSpan * Math.random());  

map.addOverlay(createMarker(latlng, i + 1));  

}  

}  

}  

 



 

 

Event: Menampilkan alert jumlah klik yang sudah dilakukan kepada peta  
Aplikasi Google Maps API juga bisa menyimpan counter, misalnya dalam program ini ditunjukkan untuk 
menyimpan counter klik.  

 

 

 

Event: Menghapus event listener  
Program berikut menunjukkan bagaimana cara menghilangkan event listener setelah klik 1 kali. Sebelumnya, 
ketika event klik program ini menghapus Marker.  

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.81861119), 13);  

 

GEvent.addListener(map,"click", function(overlay,latlng) {  

if (latlng) {  

var myHtml = "Latitude & Longitude:  

" +map.fromLatLngToDivPixel(latlng) + " , zoom level " + map.getZoom();  

map.openInfoWindow(latlng, myHtml);  

}  

});  

map.addControl(new GSmallMapControl());  

map.addControl(new GMapTypeControl());  

}  

}  

 

function MyApplication() {  

this.counter = 0;  

this.map = new GMap2(document.getElementById("map_canvas")); 

this.map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

GEvent.bind(this.map, "click", this, this.onMapClick);  

}  

 

MyApplication.prototype.onMapClick = function() {  

this.counter++;  

alert("Anda sudah mengklik " + this.counter +  

"kali.");  

}  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var application = new MyApplication();  

}  

}  

 



 

 

Control: Menampilkan Control sederhana  
GSmallMapControl menampilkan 4 tombol panah dan tombol zoom in dan zoom out saja dalam bentuk yang 
kecil. GMapTypeControl adalah Control untuk menampilkan, defaultnya, 3 tipe peta: peta biasa, foto satelit 
dan gabungan antara foto satelit yang ditimpa dengan peta. 
 

  
 

 

Control: Menampilkan posisi control di bagian kanan bawah peta setelah peta di-

double click  
Kode program berikut member contoh bagaimana kita bisa mengatur letak Control. Selain itu juga 
memperkenalkan event double click. 
 

function MyApplication() {  

this.counter = 0;  

this.map = new GMap2(document.getElementById("map_canvas"));  

this.map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

var myEventListener = GEvent.bind(this.map, "click", 

this,function(overlay, latlng) {  

if (this.counter == 0) {  

if (latlng) {  

this.map.addOverlay(new GMarker(latlng))  

this.counter++;  

} else if (overlay instanceof GMarker) {  

// This code is never executed as the event listener is  

// removed the second time this event is triggered 

this.removeOverlay(marker)  

}  

} else {  

GEvent.removeListener(myEventListener);  

}  

});  

} function initialize() {  

var application = new MyApplication();  

}  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")) 

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

map.addControl(new GSmallMapControl());  

map.addControl(new GMapTypeControl());  

}  

}  

 



 

 
 

 

Control: Menampilkan bentuk Control yang tidak biasa  
Kita bisa menggunakan bentuk Control yang tidak standar, tetapi dengan kemampuan yang sama. Contohnya 
adalah dengan menampilkan dua tombol, untuk zoom in dan zoom out.  
 

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas"));  

map.setCenter(new GLatLng(-6.4, 106.8186111), 13);  

var mapTypeControl = new GMapTypeControl();  

 

var topRight = new GControlPosition(G_ANCHOR_TOP_RIGHT, new 

GSize(10,10));  

 

var bottomRight = new GControlPosition(G_ANCHOR_BOTTOM_RIGHT, 

newGSize(10,10));  

map.addControl(mapTypeControl, topRight);  

GEvent.addListener(map, "dblclick", function() {  

map.removeControl(mapTypeControl);  

map.addControl(new GMapTypeControl(), bottomRight);  

}); 

map.addControl(new GSmallMapControl());  

}  

}  

 



 

 

 

Control: Menampilkan Local Search 

// A TextualZoomControl is a GControl that displays textual "Zoom In"  

// and "Zoom Out" buttons (as opposed to the iconic buttons used in  

// Google Maps).  

function TextualZoomControl() {  

}  

TextualZoomControl.prototype = new GControl();  

 

// Creates a one DIV for each of the buttons and places them in a container  

// DIV which is returned as our control element. We add the control to  

// the map container and return the element for the map class to  

// position properly.  

TextualZoomControl.prototype.initialize = function(map) {  

var container = document.createElement("div");  

 

var zoomInDiv = document.createElement("div");  

this.setButtonStyle_(zoomInDiv);  

container.appendChild(zoomInDiv);  

zoomInDiv.appendChild(document.createTextNode("Zoom In"));  

GEvent.addDomListener(zoomInDiv, "click", function() {  

map.zoomIn();  

});  

 

var zoomOutDiv = document.createElement("div");  

this.setButtonStyle_(zoomOutDiv);  

container.appendChild(zoomOutDiv);  

zoomOutDiv.appendChild(document.createTextNode("Zoom Out"));  

GEvent.addDomListener(zoomOutDiv, "click", function() {  

map.zoomOut();  

});  

 

map.getContainer().appendChild(container);  

return container; }  

 

// By default, the control will appear in the top left corner of the // map 

with 7 pixels of padding. TextualZoomControl.prototype.getDefaultPosition = 

function() {  

return new GControlPosition(G_ANCHOR_TOP_LEFT, new GSize(7, 7));  

}  

// Sets the proper CSS for the given button element. 

TextualZoomControl.prototype.setButtonStyle_ = function(button) {  

button.style.textDecoration = "underline";  

button.style.color = "#0000cc";  

button.style.backgroundColor = "white";  

button.style.font = "small Arial";  

button.style.border = "1px solid black";  

button.style.padding = "2px";  

button.style.marginBottom = "3px";  

button.style.textAlign = "center";  

button.style.width = "6em";  

button.style.cursor = "pointer";  

}  

 

function initialize() {  

if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")); 

map.setCenter(new GLatLng(-6.4, 106.8186111), 13); map.addControl(new 

TextualZoomControl());  

}  

}  

 



 

  
 

 

Control: Menampilkan Control tipe peta  
Kode program berikut menunjukkan kepada Anda bagaimana menampilkan control Map Type tanpa tipe 
Hybrid. 

 
 

function initialize() {  

if (GBrowserIsCompatible()) {  

 

// Create and Center a Map  

var map = new GMap2(document.getElementById("map_canvas")); map.setCenter(new 

GLatLng(-6.4, 106.81861119), 13);  

map.addControl(new GLargeMapControl());  

map.addControl(new GMapTypeControl());  

// bind a search control to the map, suppress result list  

 

map.addControl(new google.maps.LocalSearch(), 

newGControlPosition(G_ANCHOR_BOTTOM_RIGHT, new GSize(10,20)));  

}  

}  

GSearch.setOnLoadCallback(initialize);  

 



 

Control: Menampilkan label dengan check box untuk menampilkan atau 

menyembunyikan nama kota,dan jalan  
Dalam aplikasi, kadang kita ingin menunjukkan atau menyembunyikan nama-nama kota atau jalan. Ini 

bisa kita lakukan dalam contoh program berikut. Dalam contoh berikut, Anda dapat melihat bagaimana 
penampilan nama jalan dan kota dapat dikendalikan dengan sebuah check box (dan label) yang menempel 
pada control Map Type.  

 
 

 

function initialize() {  

if (GBrowserIsCompatible()) {  

 

var map = new google.maps.Map(document.getElementById("map_canvas"),  

{ size: new GSize(640,320) });  

 

map.removeMapType(G_HYBRID_MAP);  

map.setCenter(new GLatLng(-6.4, 106.8186111), 11);  

map.addControl(new GLargeMapControl());  

 

var mapControl = new GMapTypeControl();  

map.addControl(mapControl);  

 

}  

}  

 



 

 
 

Marker: Menampilkan Marker sederhana  
Sedikit mengulang yang sudah-sudah. Dalam contoh berikut, Anda akan melihat bagaimana menambahkan 
beberapa Marker sederhana di atas kota Depok.  
 

 

function initialize() {  

if (GBrowserIsCompatible()) {  

// define the crosshair tile layer and its required functions  

var crossLayer = new GTileLayer(new GCopyrightCollection(""), 0, 15);  

crossLayer.getTileUrl = function(tile, zoom) {  

return "./include/tile_crosshairs.png";  

}  

crossLayer.isPng = function() {return true;}  

 

// Create a new map type incorporating the tile layer  

var layerTerCross = [ G_PHYSICAL_MAP.getTileLayers()[0], crossLayer ];  

var mtTerCross = new GMapType(layerTerCross,  

G_PHYSICAL_MAP.getProjection(), "Ter+");  

 

var map = new GMap2(document.getElementById("map_canvas"),  

{ size: new GSize(640,320) } );  

map.addMapType(G_PHYSICAL_MAP);  

map.addMapType(mtTerCross);  

map.setCenter(new GLatLng(-6.4, 106.8186111), 4);  

map.addControl(new GLargeMapControl())  

 

var mapControl = new GHierarchicalMapTypeControl();  

 

// Set up map type menu relationships  

mapControl.clearRelationships();  

 

mapControl.addRelationship(G_SATELLITE_MAP, G_HYBRID_MAP, 

"Labels",false);  

mapControl.addRelationship(G_PHYSICAL_MAP, mtTerCross, "Crosshairs");  

 

// Add control after you've specified the relationships  

map.addControl(mapControl);  

}  

}  

 



 

 

 

Marker: Menampilkan Marker yang bisa dipindah  
Saya tidak bisa menunjukkan screenshot untuk kode berikut karena tidak akan banyak menggambarkan 
kondisinya. Intinya, dengan kode program berikut Anda bisa membuat Marker yang dapat dipindahkan. 
Caranya adalah dengan mendefinisikan sebuah Marker dengan option draggable bernilai true, kemudian 
menggunakan event listener dragstart dan event dragend.  

  

Marker: Menampilkan Marker dalam bentuk lain, misalnya gambar dari URL 

tertentu  
Jika bosan dengan Marker yang begitu-begitu saja, maka dalam contoh berikut, Anda bisa saja menampilkan 
Marker dalam bentuk lain, yaitu gambar/ikon dari sebuah URL.  
Baris ini:  

var blueIcon = new GIcon(G_DEFAULT_ICON);  

blueIcon.image = "http://maps.google.com/mapfiles/ms/micons/cabs.png";  

membuat sebuah instance class GIcon, kemudian mengubah properties image menjadi gambar yang sudah 
kita sediakan, misalnya di sini gambar mobil.  
 
Langkah berikutnya adalah mengatur agar markerOptions menggunakan icon yang sudah kita siapkan.  
 

// Set up our GMarkerOptions object  

markerOptions = { icon:blueIcon };  

 

Langkah terakhir adalah menampilkan Marker dengan opsi di atas: 
 
map.addOverlay(new GMarker(latlng, markerOptions)); 

function initialize() { if (GBrowserIsCompatible()) { var map = new 

GMap2(document.getElementById("map_canvas")); map.setCenter(new GLatLng(-

6.4, 106.8186111), 13); // Add 10 markers to the map at random locations 

var bounds = map.getBounds(); var southWest = bounds.getSouthWest(); var 

northEast = bounds.getNorthEast(); var lngSpan = northEast.lng() - 

southWest.lng(); var latSpan = northEast.lat() - southWest.lat(); for (var 

i = 0; i < 10; i++) { var latlng = new GLatLng(southWest.lat() + latSpan * 

Math.random(), southWest.lng() + lngSpan * Math.random()); 

map.addOverlay(new GMarker(latlng)); } } }  

 

function initialize() { if (GBrowserIsCompatible()) { var map = new 

GMap2(document.getElementById("map_canvas")); var center = new GLatLng(-

6.4, 106.8186111); map.setCenter(center, 13); var marker = new 

GMarker(center, {draggable: true}); GEvent.addListener(marker, 

"dragstart", function() { map.closeInfoWindow(); }); 

GEvent.addListener(marker, "dragend", function() {  

marker.openInfoWindowHtml("Just bouncing along..."); }); 

map.addOverlay(marker); } }  

 



 

  
 

 
  

Icon marker bisa didapat dari http://abeliantechnologies.com/google_map_marker.php atau Anda buat 
sendiri.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function initialize() { if (GBrowserIsCompatible()) {  

var map = new GMap2(document.getElementById("map_canvas")); 

map.setCenter(new GLatLng(-6.4, 106.8186111), 13); map.addControl(new 

GSmallMapControl()); map.addControl(new GMapTypeControl()); // Create our 

"tiny" marker icon var blueIcon = new GIcon(G_DEFAULT_ICON); 

blueIcon.image = "http://maps.google.com/mapfiles/ms/micons/cabs.png"; // 

Set up our GMarkerOptions object markerOptions = { icon:blueIcon }; // Add 

10 markers to the map at random locations var bounds = map.getBounds(); 

var southWest = bounds.getSouthWest(); var northEast = 

bounds.getNorthEast(); var lngSpan = northEast.lng() - southWest.lng(); 

var latSpan = northEast.lat() - southWest.lat(); for (var i = 0; i < 10; 

i++) { var latlng = new GLatLng(southWest.lat() + latSpan * Math.random(), 

southWest.lng() + lngSpan * Math.random()); map.addOverlay(new 

GMarker(latlng, markerOptions)); } } } 



 

LAMPIRAN HASIL INVENTARISASI 
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Database Sekolah Dasar Negeri 
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